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Limited Warranty, Limitations Of Liability And Restrictions 

Geophysical Survey Systems, Inc. hereinafter referred to as GSSI, warrants that for a period of  

24 months from the delivery date to the original purchaser this product will be free from defects 

in materials and workmanship. EXCEPT FOR THE FOREGOING LIMITED WARRANTY, 

GSSI DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING ANY 

WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

GSSI's obligation is limited to repairing or replacing parts or equipment which are returned to 

GSSI, transportation and insurance pre-paid, without alteration or further damage, and which in 

GSSI's judgment, were defective or became defective during normal use. 

GSSI ASSUMES NO LIABILITY FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL 

OR CONSEQUENTIAL DAMAGES OR INJURIES CAUSED BY PROPER OR IMPROPER 

OPERATION OF ITS EQUIPMENT, WHETHER OR NOT DEFECTIVE. 

Before returning any equipment to GSSI, a Return Material Authorization (RMA) number must 

be obtained. Please call the GSSI Customer Service Manager who will assign an RMA number. 

Be sure to have the serial number of the unit available 

 

FCC Class B Compliance 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 

conditions: (1) this device may not cause harmful interference, and (2) this device must accept 

any interference received, including interference that may cause undesired operation. 

Warning: Changes or modifications to this unit not expressly approved by the party responsible 

for compliance could void the user‟s authority to operate the equipment. 

Note: This equipment has been tested and found to comply with the limits for a Class B digital 

device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 

protection against harmful interference when the equipment is operated in a commercial 

environment or residential installation. This equipment generates, uses, and can radiate radio 

frequency energy and, if not installed and used in accordance with the introduction manual, may 

cause harmful interference to radio communications. However, there is no guarantee that 

interference will not occur in a particular installation.  

Shielded cables must be used with this unit to ensure compliance with the Class B FCC limits. 

Canadian Emissions Requirements 

This Class B digital apparatus complies with Canadian ICES-003. 

Cet appareil numerique de la classe A est conforme a la norme NMB-003 du Canada. 

Declaration of CE Conformance 

The Profiler EMP-400 has been certified to meet the requirements of the following European 

standards: 

 EN61326:1997, A1:1998, A2:2001 



Geophysical Survey Systems, Inc. Profiler EMP-400 
 User’s Manual 
 

MN37-230 Rev- 

 



Geophysical Survey Systems, Inc. Profiler EMP-400 
 User’s Manual 
 

MN37-230 Rev- 

Table Of Contents 

Chapter 1: Introduction ................................................................................................. 1 
1.1 Unpacking Your System........................................................................................ 1 
1.2 General Description .............................................................................................. 2 
1.3 The Profiler EMP-400............................................................................................ 3 

1.4 The Profiler Removable Battery Pack ................................................................... 4 
1.5 TDS Recon-400 PDA ............................................................................................ 7 
1.6 TDS Recon-400 Power Boot Module and  AA Power Boot Module ...................... 9 
1.7 PDA Mount and Low Carry Handle ..................................................................... 11 
1.8 RF Key Fob ......................................................................................................... 14 

Chapter 2: Profiler EMP-400 Setup ............................................................................ 15 
2.1 Starting the EMP-400 .......................................................................................... 15 

2.2 Recall Setup ........................................................................................................ 19 
2.3 Check System Diagnostics Parameters .............................................................. 19 

2.3 Check System Parameters ................................................................................. 32 
2.4 System Calibrations ............................................................................................ 37 

2.5 Select Grid Configuration (Grid Config.).............................................................. 41 
2.6 Review Parameters ............................................................................................. 45 
2.7 Save Setup ......................................................................................................... 47 

Chapter 3: Collecting Data ......................................................................................... 49 
3.1 Set Data Display Parameters .............................................................................. 49 

3.2 Data Collection .................................................................................................... 50 
3.3 Data Review ........................................................................................................ 56 
3.4 Shutting Down the System .................................................................................. 61 

Chapter 4: Transferring, Converting and  Exporting EMP-400 Data ....................... 63 

4.1 Transferring Data ................................................................................................ 63 
4.2 Transferring Data Using ActiveSync ................................................................... 64 
4.3 Transferring Data Using File Transfer Utility ....................................................... 69 
4.4 Converting Files in MagMap2000 ....................................................................... 70 

4.5: Working with *.EMI and GPS Files in MagMap2000 .......................................... 73 

Appendix A: Understanding GPS And WAAS .......................................................... 83 

Appendix B: Example of GGA Data String ................................................................ 87 

Appendix C: Conducting a Survey ............................................................................ 89 

Appendix D: Useful References ................................................................................. 95 

 



Geophysical Survey Systems, Inc. Profiler EMP-400 
 User’s Manual 
 

MN37-230 Rev- 



Geophysical Survey Systems, Inc. Profiler EMP-400 
 User’s Manual 

MN37-230 Rev- 1 

Chapter 1: Introduction 

This user manual has been written for both the novice and the experienced user of 

electromagnetic induction (EM) instruments. This manual is provided as an operational reference 

tool. It is highly recommended that the user read the entire manual, regardless of your level of 

experience with electromagnetic induction theory, applications, and other instrumentation. 

Appendix A contains useful information about GPS. Appendix B is a summary of the basic steps 

in conducting an EM survey. For additional information on EM theory and applications please 

review the list of references, which can be found in Appendix C.  

1.1 Unpacking Your System 

Thank you for purchasing a GSSI Profiler EMP-400 electromagnetic induction (EM) instrument 

(hereinafter referred to as the EMP-400). A packing list was included with your shipment, which 

identifies all of the items that are in your order. If you find that an item is missing, or damaged 

during shipment, please call, or fax your sales representative immediately so that GSSI can take 

steps to correct the problem. 

Your EMP-400 system (Standard Configuration) includes the following items: 

1 – EMP-400 Transit case (large). This includes: 

 1 – Profiler EMP-400 digital electromagnetic induction instrument 

 1 – Low carry handle and mounting clamps 

 1 – Hip height padded shoulder carrying strap and mounting straps 

 1 – EMP-400/Recon-400 PDA mounting bracket and clamp 

 

1 – EMP-400 Transit case (small). This includes: 

 1 – TDS Recon PDA with integrated Bluetooth service and Holux  WAAS GPS module 

 1 – AC rechargeable power boot module for Recon-400 PDA 

 1 – AA battery power module for Recon-400 PDA 

 1 –120 V AC re-charger for Recon-400 power boot module 

  (see PDA manual for Input/Output specifications for International AC charger) 

 1 – Battery charger for EMP-400 Li-Ion battery 

 1 – AC power supply for Li-Ion battery charger 

 1 - AC power cord for AC battery charger power supply 

 2 – Re-chargeable Li-Ion batteries for EMP-400 

 1 – AA backup battery pack for EMP-400 

 1 – RF remote control key fob and lanyard 

 1 – PDA stylus pen and lanyard 

 1 – USB data transfer cable 

 1 – Spare stylus pen 

 1 – Package of PDA screen protectors (10 count) 

 1 – Recon-400 hand strap 

 1 – User‟s Manual 
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 1 – User‟s CD containing the unit‟s backup calibration files, Geometrics MagMap2000 

 software and a *.PDF copy of the User‟s Manual, the Profiler File Transfer Utility 

 Program and the MagMap 2000 manual 

 1 – Profiler QuickStart Guide 

 1 – TDS Recon Getting Started Guide 

 1 – TDS Recon Companion CD 

 1 – OEM copy of Microsoft  Windows Mobile  2003 software for Pocket PC‟s 

1.2 General Description 

Electromagnetic induction instruments find application in many different types of geological and 

environmental areas. These include shallow soils mapping, soil-salinity mapping, ground water 

investigations, the detection, and delineation of waste pits and associated subsurface 

contaminants from acids, salts, or VOC‟s. They have also been used extensively for the detection 

of conductive geologic media such as clays and ferrous mineral deposits, as well as the detection 

of resistive geologic media such as gravel deposits. In addition, the systems are used for near-

surface archaeological investigations, the detection of buried structures such as building 

foundations, as well as for the detection of conductive metallic objects such as drums, tanks, 

large utilities and other non-descript buried metallic objects. 

The Profiler EMP-400 is a digital, portable, multi-frequency electromagnetic induction sensor. 

The user can collect up to three discrete frequencies simultaneously. The system bandwidth 

extends from 1 kHz to 16 kHz in 1 kHz steps. The system‟s primary data output is the orthogonal 

components (In-Phase and Quadrature) of the mutual coupling field ratio (Q) of the transmitted 

field to the induced field in parts per million (PPM), and apparent conductivity ( A) at 15 kHz. 

The In-Phase and Quadrature components of the induced secondary field, as well as the apparent 

conductivity, are collected and stored for each reading along with a time stamp. GPS data, in the 

form of a NMEA 0183 GGA string, is also recorded if the WAAS GPS is enabled, or if an 

external high-resolution GPS system is interfaced with the PDA via its RS-232 serial port. 

The system sensor electronics are controlled via a wireless Bluetooth  communications 

interface. The system user interface and data storage are incorporated into a TDS RECON-400 

Personal Digital Assistant (PDA) provided with the system. The instrument weighs 10 lbs. The 

system coil configuration is Horizontal Co-Planar (HCP). The inter coil spacing is 1.219 meters. 

Data can be collected in both the vertical (VDM) and horizontal (HDM) dipole modes. The 

instrument is powered by a re-chargeable Li-Ion battery pack, or by eight (8) AA batteries. The 

PDA is powered by an AC rechargeable power pack or optional AA battery power pack. The 

PDA is configured with an integrated 12-channel WAAS (Wide Area Augmentation System) 

GPS that enables the user to collect geo-referenced data. The EMP-400 system and the TDS 

Recon-400 PDA are environmentally sealed and self contained and have no user serviceable 

parts. The major system components are the EMP-400, the EMP-400 battery pack and the  

TDS Recon-400 PDA. These are illustrated in Figures 1 through 8. 
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1.3 The Profiler EMP-400 

 

Figure 1: EMP-400 Top View. 

 

Figure 2: EMP-400 Bottom View. 

The EMP-400 has no external connectors or I/O ports. An expanded view of the EMP-400 

electronics enclosure is illustrated in Figures 3 and 4. 

 

Figure 3: EMP-400 top view showing the location of the system power switch,  

Bluetooth communications status and system status lights. 

The EMP-400 is powered by re-chargeable Li-Ion batteries. The batteries are accessible via the 

removable battery pack located on the bottom of the electronics assembly (Figure 4). 
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Figure 4: EMP-400 Electronics Assembly bottom view showing the location of removable battery pack 

outlined in red. 

1.4 The Profiler Removable Battery Pack 

The EMP-400 battery pack is removed from the unit by gently pulling the removable battery 

pack retaining springs towards each other (towards the center of the battery pack) until they snap 

out from beneath the four (4) delrin retaining clips screwed into the bottom of the EMP-400 

electronics assembly (Figure 4 above and Figure 7 below). The locks on the battery pack 

retaining clips prevent the clips from accidentally from opening when the EMP-400 base brushes 

against tall grass, field stubble or other surface objects. Engage the locks by turning the clip 

locks 90 degrees clockwise. The operator can use the reverse end of the PDA stylus to turn the 

locks. 

 The removable battery pack accepts the 10.8 VDC Li Ion batteries provided with your 

system. Operation time of the Li Ion battery on a single charge is 9 hours minimum when 

operating at one measurement per second at ambient temperature of +15
o 
C to +35

o 
C. 

Operation time of the Li Ion battery on a single charge is 18 hours typical (typ) when 

operating at one measurement per second at ambient temperature of +25
o 
C. Life 

expectancy is 300 charge/discharge cycles. The discharge temperature limits are -10
o 
C to 

+50
o 
C. The storage temperature limits are -20

o 
C to +60

o 
C. 

 A full battery is indicated by five (5) rectangular squares located on the battery gas gauge 

on the end of the battery opposite the five (5) battery contact slots. 

 The EMP-400 Li Ion batteries should be placed in the Li Ion charger when the battery gas 

gauge reaches one (preferably two) squares. The time required to recharge a battery is three 

and a quarter hours for a fully discharged battery. 

 The removable battery pack also accepts eight (8) AA 2500 NiMH batteries for system 

power backup when the Li Ion batteries are recharging. The operating time for AA batteries 

at one measurement per second at an ambient temperature of +25
o 
C:  

Retaining Clip Locks 
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 Rechargeable: NH15-2500 NiMH 2500 mAH battery = 20 hours 

The rechargeable Li Ion battery pack and AA battery packs are illustrated in Figures 5 and 6. 

 

Figure 5: Re-chargeable Li-Ion battery pack and removable battery pack housing. 

 

Figure 6: AA battery pack and removable battery pack housing. 

Five (5) DC battery 
contact slots 

Battery pack insertion 
guidepost and battery 

retainers 

Two (2) battery pack 
housing springs 



Geophysical Survey Systems, Inc. Profiler EMP-400 
 User’s Manual 

MN37-230 Rev- 6 

Installing the EMP-400 Batteries 

1. The Li Ion battery or AA battery pack is inserted into the EMP-400 battery pack by 

inserting the battery and gently pinching the battery pack housing springs back until the 

battery (or AA battery pack) snaps into place. The user should insert a fully charged Li Ion 

or AA battery pack into the EMP-400 battery pack housing. 

2. The entire EMP-400 battery pack is then inverted, and then inserted into the EMP-400 

electronics enclosure. The user should gently squeeze the battery pack retaining clips and 

then insert the battery pack into the EMP-400 electronics assembly using the insertion 

guideposts.  

 The user must be sure that the battery has been installed into the removable battery pack 

correctly. The five (5) DC contact slots on the Li Ion or AA battery pack should align with 

the DC battery terminals located on the EMP-400 electronics assembly board inside the 

removable battery pack enclosure. The battery should be inserted so that the five (5) battery 

contact slots are facing UP (Figures 5 and 6).  

3. Press gently on the top of the battery pack until the retaining springs click into place  

(Figure 7). Be certain the clip locks have been rotated counter-clockwise (unlocked) before 

pressing on the retaining springs. 

 The pack can be removed by gently pinching the battery pack housing springs until the 

springs un-snap from beneath the four white battery pack housing clips (Figure 7). 

4. The system can now be turned ON by depressing the EMP-400 power button located at the 

front of the EMP-400 electronics assembly (Figure 3). The Green power LED should 

illuminate. This indicates that the EMP-400 is receiving power from the battery pack and 

that the voltage level of the batteries is sufficient to operate the system. 

 

Figure 7: Inserting the removable battery pack into the EMP-400 electronics. 

DC battery 
terminals 

Battery pack 
housing springs 

Gently squeeze 
springs to insert 

housing 

Battery pack 
housing clips 
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1.5 TDS Recon-400 PDA 

The Tripod Data Systems (TDS) Recon-400 is a portable, field rugged PDA. It is the platform 

for the Graphic User Interface and primary data storage of the EMP-400.  

Note: GSSI assumes no responsibility for Profiler interface operating problems if the user 

installs any other third-party software onto the PDA. 

Specifications 

 The Recon-400 incorporates an Intel PXA255 X Scale CPU running at 400 MHz.  

 It is configured with 64 MB high-speed SDRAM and 256 MB of non-volatile storage.  

 The system display is a 240 X 320 pixel (1/4 VGA) color TFT display with LED front light. 

 It is configured with integrated Bluetooth  communications and a HOLUX  WAAS GPS 

receiver. 

 Available Profiler PDA user storage memory 248 MB. The system is capable of storing 

~400,000 EMP-400 readings in Continuous mode and 500,000 readings in the Discrete 

mode. The maximum number of readings in each mode is a function of the grid dimensions: 

x-range, y-range, line spacing and reading spacing (step). See Chapter 3.0, Section 3 Grid 

Configuration. 

 The PDA weighs 17 ounces and has an operating temperature range of -30  to +60  C. 

Storage temperature limits are -40 to +70  C. Battery life is 500 charge/discharge cycles 

(typical) if battery is stored at least partially charged between 0  to +35  C. 

 The system meets MIL-STD-810F standards for humidity, water (accidental immersion), 

drop, vibration, humidity, and altitude. It has an IP67 rating and is impervious to water and 

dust. 

 A rechargeable 3800 mAh NiMH DC power boot module or an optional AA battery power 

boot module supplies power to the unit.  

 Input/Output ports include a D-shell RS-232 serial port, a USB data port, as well as an AC 

charging port for the AC power boot module.  

 The Operating System software is Windows  Mobile 5.0.  
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Figure 8: TDS RECON-400. 

TDS Recon-400 PDA Connectors 

The TDS Recon-400 has three (3) primary connectors: One (1) AC battery charger connector, 

One (1) D-Shell RS-232 serial port connector and one (1) USB data port (Figure 9). 

 

Figure 9: TDS RECON-400 Connectors. 
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TDS Recon-400 PDA Power And Batteries 

The Recon-400 Windows 5.0 operating system has on board power management and a battery 

gas gauge. 

 PDA battery level information is accessible by selecting the Windows Start tray icon and 

selecting the Settings option.  

 Select the System tab, then the battery icon to determine main battery power level and 

backup battery power levels.  

 The Advanced options should then be selected to modify the Windows™ default On 

Battery Power device shut down and On External Power device shut down times: These 

selections should be turned OFF to prevent inadvertent shutdown of the system and 

interruptions of Bluetooth communications during a survey. 

 Screen Power and Brightness parameters can be modified using the same sequence to 

access the System menu and then selecting the Backlight icon.  

 When using the AC rechargeable power boot module, under normal operating conditions, 

the Recon-400 should operate for up to 4.5 hours. When using the WAAS GPS system, 

operating time drops to ~2.5 hours. 

 Operating the PDA with less than 25% battery power may result in intermittent loss of 

Bluetooth communication and potential loss of data. GSSI recommends that the PDA 

power boot module be recharged when the power level reaches 25%. 

Note: Under no conditions should the user modify the Screen parameters. These set the display 

window orientation. The window orientation is set to Portrait by default. Changing the window 

orientation could lead to unpredictable operating (display) results when running the Profiler 

interface. GSSI assumes no responsibility for Profiler interface operating problems if the 

display orientation is changed by the user. 

Note: The user should place the PDA on charger upon unpacking the instrument. The 

Windows 5.0 operating system is stored in non-volatile memory, however, GSSI recommends 

placing the PDA on the charger for several hours after every survey, or when that PDA battery 

gas gauge reads 25% or less. 

1.6 TDS Recon-400 Power Boot Module and  
AA Power Boot Module 

Your Recon-400 is supplied with two (2) interchangeable DC power supplies (Figures 10 and 

11). The system is configured with the AC rechargeable power boot module installed.  

 The power boot modules can be removed from the PDA by turning the module locking tabs 

to the unlocked position.  
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 Your Recon-400 is supplied with a screen stylus that has a screwdriver tool opposite the 

stylus end. This tool is used to lock and unlock the power boot modules and the protective 

cap for the WAAS GPS card and to secure the locks on the removable battery pack. The 

modules can be secured by returning the locking tabs to the locked position. The location of 

the locking tabs is illustrated in Figure 11.  

 The AA power boot module accepts two (2) AA batteries. Under normal operating 

conditions and with the appropriate batteries, the AA power boot module will operate for 

approximately 2-3 hours. When using the WAAS GPS system, operating time drops to 

1.5 hours. 

 

Figure 10: PDA AA power boot module (front). 

 

Figure 11: PDA AA power boot module (back). 

Power boot module 
locking tabs 

Stylus holder 
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 The AA power boot module is provided as a BACKUP to the standard AC power boot 

module. The user should at no time use the AA power boot module as the primary power 

source. The AA power boot module is for use while the AC power boot module is 

recharging. The AC power boot module requires approximately 1-2 hours to fully recharge.  

Note: GSSI strongly recommends the user obtain rechargeable 2500 mAh batteries for use in 

the AA power boot module. These batteries can be found at most electronics and/or hardware 

supply store or any commercial retailer that sells standard AA batteries. The AA power boot 

module endurance times given above are for 2500 mAh rechargeable batteries. GSSI assumes 

no responsibility for PDA operating times and/or PDA operating problems encountered if 

the user installs standard AA batteries in the AA power boot module. 

1.7 PDA Mount and Low Carry Handle 

PDA Mount  

Your EMP-400 is supplied with both a shoulder strap, for hip height deployment, and a low carry 

handle for near surface deployment. The system is supplied with two (2) Velcro cinch straps that 

are secured to the EMP-400 tube-body by adjusting the strap tension. The straps have attached 

plastic clips, allowing the user to clip the EMP-400 carrying strap to the cinch straps. The Velcro 

cinch straps and the shoulder-carrying strap are adjustable. The EMP-400 shoulder strap should 

be adjusted so that the EMP-400 is approximately 1 meter from the ground surface or at 

approximately hip height during data collection. 

The PDA mount (Figure 12) attaches to the main tube of the EMP-400 with a screw-clamp. The 

PDA is designed to slip into the black plastic bracket on the PDA mount. If inserted properly, the 

PDA should click into place. The orientation of the PDA can be adjusted for easy viewing by the 

operator. The PDA mount incorporates a lockable ball joint and armature adjustment that allows 

the user to adjust the pitch and the angle of the PDA screen. When the desired pitch and angle 

adjustment has been made, use the ball joint locking lever to lock the PDA into position by 

moving the lever from the horizontal to vertical position. Do not force the ball joint armature 

without unlocking the ball joint. This will damage the ball joint.  
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Figure 12: PDA Adjustable Mounting Bracket and Clamp. 

Note: It is not recommended that the PDA clamp be attached to the EMP-400 when the low 

carry handle is used. The PDA display will not be visible to the user. The PDA mount and low 

carry handle clamp screws should be screwed into the clamp so that the threaded brass insert is 

on the opposite side of the clamp from the screw head (Figure 12). 

Figure 13 illustrates the PDA mount with the PDA inserted and the shoulder carry strap attached 

to the EMP-400 tube. The PDA mount clamp should be attached to the EMP-400 tube so that the 

clamp butts up against the tube section to which the electronics enclosure is attached. This 

position provides better balance to the instrument when using the shoulder strap. 

 

Figure 13: EMP-400 with the PDA mount and PDA installed. 
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Low Carry Handle 

The EMP-400 can be deployed with a low carry handle. The handle allows the user to carry the 

EMP-400 in closer proximity to the ground surface. In general, the closer the proximity of the 

EMP-400 to the ground surface, the greater the In-Phase response. In addition, the handle 

enables the user to switch from VDM mode the HDM mode simply by loosening the handle 

screws and rotating the instrument 90 . The low carry handle is attached to the EMP-400 tube by 

screwing in the two screw-clamps provided with the handle. As indicated above, the screws 

should be inserted into the clamps so that the brass threaded insert is opposite the screw head. 

The low carry handle, clamps, and clamp screws are illustrated in Figure 14. 

 

Figure 14: EMP-400, low carry handle and two (2) screw clamps. 

 

Figure 15: Attaching clamps for low carry handle. 
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Attaching and Adjusting Low Carry Handle 

1. Position a clamp and the handle tube as shown in Figure 15 and insert the clamp screw 

through the blind side of the handle clamp, i.e., the side of the clamp opposite the threaded 

brass insert, and through the rubber bushings at the bottom of the carry handle.  

2. Slowly screw the threaded clamp screw through the clamp and handle until the screw is 

tight. 

3. Repeat this process with the other handle clamp.  

 The height of the handle can be adjusted by loosening the handle clamps and sliding them 

towards (lower) or away (higher) from the EMP-400 coils.  

 The user can also adjust the handle height by removing the rubber handle screw and 

repositioning the rubber handle in one of the three (3) pre-drilled holes in the carry handle.  

 The level of the EMP-400 can be adjusted by loosening the two handle level screws 

beneath the handle and adjusting the handle until the handle and EMP-400 are level. The 

handle level can be checked by placing the EMP-400 on a flat surface and handle screws 

adjusted as necessary. 

 The recommended deployment height when using the low carry handle is 8 inches (20 cm) 

from the ground surface. 

1.8 RF Key Fob 

The EMP-400 is supplied with an RF key fob for remote Start/Stop of EMP-400 data acquisition 

and for placing fiducial marks in data files collected in the Continuous mode (Figure 16).  

 

 

Figure 16: RF Key fob. 

 

Mark button 

Start/Stop button 
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Chapter 2: Profiler EMP-400 Setup 

2.1 Starting the EMP-400 

1. Prior to starting system setup and data acquisition, insert a fully charged Profiler Li-ION 

battery into the removable battery pack (see Section 1.4: Profiler Removable Battery Pack).  

2. Turn ON the EMP-400. The Green power status light next to the EMP-400 power switch 

will illuminate (Figure 19 and 20). The Blue Bluetooth communication status lights will 

also illuminate. When the EMP-400 Li Ion battery reaches a power low condition, the 

Green power status light will begin to blink. 

3. Turn ON the PDA by depressing the PDA Power ON/OFF button. 

` 

Figure 17: Profiler power switch and power LED location. 
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Figure 18: PDA power ON. 

4. After PDA power up, the RECON-400 Windows  Start splash screen will be displayed  

(Figure 19). 

 

Figure 19: Windows 5.0 start screen. 

When the power is first applied to the PDA, the Bluetooth icon on the Windows 5.0 Start screen 

will indicate that the Bluetooth is Off. GSSI has modified the Windows 5.0 Wireless Manager to 

automatically enable the Bluetooth communication. Approximately 8 seconds after PDA power 

is turned on, the Bluetooth communication will be turned on. 
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Figure 20: Bluetooth communication on. 

5. To start the EMP-400 interface, do one of the following: 

 Use the dedicated Profiler Start PDA keypad button (Figure 18) (recommended). 

 Use the Windows Start icon located at the top of the PDA splash screen. Tap Start >Red 

Profiler icon located on the pull-down menu (Figure 21). 

 

Figure 21: Profiler Start icon. 

Note: The operator should use the windows System command (as described in 1.6 TDS Recon-

400 Power Boot Module and  

AA Power Boot Module) to access the clock settings for the PDA to set the appropriate time and 

date prior to collecting data with the system. Another alternative method is to connect your PDA 

to your computer with your USB cable. Launch the Windows ActiveSync program to establish 

connection with your PC. Once a connection is established, the time and date on the PDA will 

automatically be updated to the time and date displayed by your computer system clock and 

calendar. This is discussed in detail in ?????Chapter 5, Section 5.1. 

6. Upon initialization of the EMP-400 user interface, the Profiler splash screen will appear 

(Figure 22). Beneath the splash screen a Blue progress bar will appear.  

Profiler Start icon 
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 It will take the PDA approximately 30-40 seconds to load the Profiler software and 

establish communications with the EMP-400. 

 When initialization of PDA/EMP-400 communications is complete, the progress bar and 

splash screen will disappear. 

 

 

Figure 22: Profiler EMP-400 - Start splash screen and progress bar. 

7. The PDA will then display the EMP-400 Main menu (Figure 23). At the bottom of the 

screen, the PDA battery gas gauge, the speaker status (On/Off) and the current system time 

are displayed. 

 

Figure 23: Profiler Main menu 

GSSI recommends that the operator utilize the PDA stylus to make all system parameters 

selections. Nails, pens, pencils, etc. will damage the touch screen. The PDA is supplied with 

screen protectors. GSSI strongly urges the user to use these and replace them when necessary. 

PDA Status Bar: 

Displays the PDA power level, 
speaker status and system time  
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2.2 Recall Setup 

The operator can store up to 28 user-defined setups in addition to the 2 predefined system setups 

in the EMP-400 PDA memory. Select Main > Recall Setup (Figure 24). The operator should 

select the desired Setup number with the PDA stylus and then press the Enter key on the PDA. 

All the saved data acquisition parameters will be loaded, except the GPS setup. The WAAS GPS 

must be turned on manually and a GPS test conducted to access the GPS signal condition and 

GPS validity. If the operator is using an external GPS system, it should be connected to the PDA 

serial communications port at this time (see page 31, Settings for an External GPS System). 

 

Figure 24: Recall Setup menu. 

2.3 Check System Diagnostics Parameters 

DIAGNOSTICS Menu 

Examine the parameters in the Diagnostics menu (Figure 25) to ensure that the system is 

properly configured by selecting Main > Diagnostics. 

 

 GUI (page 20) 

 Firmware (page 20) 

 Upgrade Firmware (page 20) 

 System Calibrations (page 20) 

 Display Preferences (page 25) 

 System Setup (page 29) 

 

 

 

Figure 25: System Diagnostics menu. 



Geophysical Survey Systems, Inc. Profiler EMP-400 
 User’s Manual 

MN37-230 Rev- 20 

GUI 

The Diagnostics menu contains information on the Graphic User Interface (GUI) version 

installed on your PDA. This field is for information purposes only and cannot be changed or 

accessed by the user.  

FIRMWARE 

This menu contains information on the Firmware version number installed on your PDA. This 

field is for information purposes only and cannot be changed or accessed by the user. 

Upgrade Firmware 

This function can only be accessed by GSSI Field Service. 

System Calibrations 

The Systems Calibrations section of the EMP-400 allows the user to perform several calibration 

functions. This menu controls the Field, User and Free Space Calibration functions of the 

instrument. The user should not run the EMP-400 Free Space Calibration. The EMP-400 has 

been Free Space calibrated at the factory. Once the calibration is performed, the calibration files 

are stored in the system memory (Figure 26). 

 

Figure 26: Free Space Calibration. 

Important Notice Regarding EMP-400 Calibration Files 

Note: The user should never move or delete the Profiler EMP-400 Calibration files 

(Profiler.CAL and Profiler.PRM) from the root PDA directory: \\My Windows Mobile-Based 

Device\My Device\Program Files\Profiler. Moving or deleting these files will compromise the 

EMP-400 calibration. They are not user accessible files.  

Copies of these files can be found on the Profiler Accessory CD that was supplied with your 

system. If for any reason you suspect that the calibration files have been corrupted, or are 

mistakenly deleted, they can be copied from the backup CD directly into the PDA \\My 

Windows Mobile-Based Device\Program Files\Profiler directory. These backup files allow the 

user to restore the system calibration and parameter files.  
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GSSI recommends that these files be copied from the Profiler Accessory CD and stored in a safe 

location on your PC as additional backup in the event the Accessory CD and the calibration files 

on it are lost or become corrupted or damaged.  

The Profiler EMP-400 employs a continuously self-calibrating system. In the event of system 

calibration failure (or corruption or deletion of the system calibration file) the EMP-400 will 

prompt the user with an error message: “FAILED TO OPEN PROFILER PARAMS FILE,” or 

“FAILED TO: OPEN CALIBRATION FILE.” If the user is prompted with this warning, the 

backup calibration and parameter files will have to be re-loaded into the PDA\\My Windows 

Mobile-Based Device\Program Files\Profiler directory.  

If the user inadvertently selects the Free Space Calibration function while performing system 

calibrations, the following Warning Message will be displayed (Figure 27). 

 

Figure 27: Free Space Calibration system warning. 

 If this warning should appear, the operation should select No.  

 If the operator inadvertently selects Yes, the Profiler will immediately begin the Free Space 

Calibration procedure. At this point, the operator must let this procedure run until 

completion. If the operator attempts to terminate the calibration procedure before it is 

completed, the Profiler interface will freeze. At this point, it will be necessary for the 

operator to re-boot the PDA and turn off the Profiler and re-establish Bluetooth 

communications between the PDA and the EMP-400 (see Section 1.2). 

 Once the Free Space Calibration is complete, the operator will have to replace the Profiler 

calibration files (described below). 

To Replace Profiler Calibration Files: 

1. Connect the PDA to the PC with the USB cable provided with your system (see Section 4.1 

Transferring Data). Locate the folder where your backup Calibration Files are stored. This 

folder will include a PROFILER.CAL file and a PRFOILER.PRM file. 

2. Wait for ActiveSync to prompt you with the Pocket PC Sync Setup Wizard. Select Cancel 

as you do not want to establish a sync relationship between the PDA and your computer 

(Figure 28). 
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Figure 28: Pocket PC Sync Setup Wizard. 

3. ActiveSync will then connect the PDA and PC and the ActiveSync connection window will 

appear. When connection is established, the ActiveSync window will display Connected 

(Figure 29). 

 

Figure 29: ActiveSync window. 

4. Access the PDA Operating system and memory by selecting the Explore icon. This will 

access the Mobile Device window (Figure 30). 

 

Figure 30: Mobile device window. 

5. The user should now select the My Windows Mobile-Based Device icon. This will access 

the PDA Root directory (Figure 31). 



Geophysical Survey Systems, Inc. Profiler EMP-400 
 User’s Manual 

MN37-230 Rev- 23 

 

Figure 31: PDA Root directory. 

6. The user should now select the Program Files folder. This will allow access to the Profiler 

Program folder (Figure 32). 

 

Figure 32: Profiler Program folder. 

 The user should now select the Profiler folder. In this example, this folder contains the 

following files/folders: PROFILER_MEM_56K, PROFILER.EXE, PROFILER.PRM, 

PROFILER#.CAL (# indicates EMP-400 serial number). The files PROFILER.PRM, and 

PROFILER#.CAL are the system calibration files.  

 

 

Figure 33: Contents of Profiler directory. 

Note: The user should NEVER move or attempt to access the Profiler executable or the 

PROF_MEM_56K file. Doing so will damage the files and prevent the system from operating. 
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GSSI assumes no liability for the proper operation of the EMP-400 if these files are moved or 

accessed. 

7. The user should Copy the backup PROFILER#.CAL and PROFILER.PRM from their PC 

to the Profiler Program Files folder. Upon transfer of the calibration files from the PC to the 

PDA, the system will prompt the user with a file conversion request. The user should select 

OK when prompted with this request. The Calibration files have now been replaced. 

8. The user can now disconnect the PC from the PDA by disconnecting the USB ActiveSync 

cable. 

9. Restart the EMP-400 and the PDA as described at the start of Chapter 2. 
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DISPLAY PREFERENCES Menu 

After selecting the appropriate data display and the display limits, return to the Main menu and 

select Diagnostics > Display Preferences (Figure 34). 

 START DISPLAY (page 25) 

 SCREEN COLORS (page 25) 

 DATA DISPLAY COLORS (page 26) 

 DATA DISPLAY LIMITS SETUP (page 27) 

 MAP SMOOTHING (page 28) 

 DATA SMOOTHING (page 28) 

 

Figure 34: Display Preferences menu. 

START DISPLAY 

The Start Display is the user-specified display opened when data collection is started. The two 

options are Data Display or Position Display. During data collection, it is possible to toggle 

between the Data and Positioning displays by tapping on the current screen. 

 If Data Display is enabled, the acquired data will be displayed on the PDA screen as it is 

collected. 

 If Position Display is enabled, the survey location points, as defined by the survey grid or 

the GPS track of each transect, will be displayed as data is collected. 

SCREEN COLORS 

The Screen Colors menu enables the user to customize all of the system setup menus, tool bar 

labels and background colors. Customization of the system displays is entirely up to the user. In 

some cases, it may be desirable to change the colors of certain fields to enhance the menu display 

in high (or low) ambient light conditions. Both the Text and Background color of the EditBox, 

Header, Label and function Button may be customized.  

 

Figure 35: Screen Colors menu. 
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Background: To change the Background, select Backgr next to the specific field you wish to 

customize and then select the desired color from the color palette on the left of the display.  

Text: To change the color of the Text, select Text next to the specific field you wish to 

customize and then select the desired color from the color palette on the left of the display.  

Function Button: Customization of the Function button includes the Text, Background, Border, 

Focus Text and Focus Background. Customization of the Text and Background for the Function 

buttons are the same as that for the EditBox, Header and Label.  

Function Button Border: The function Button Border (the border around the Function button) 

Focus Text (active menu selections under the function Button) and Focus Backgr (the 

background behind the Focus Text) allow the user to further customize the function Buttons as 

desired.  

 We recommend that the user experiment with these functions. Once the desired colors have 

been chosen, select Save.  

 At any time, the user may return the system to the default color settings by selecting 

Default.  

1. When you are satisfied with your changes, select Save, then OK from the PDA Status Bar 

to return to the Display Preferences menu.  

2. Select OK from the PDA Status Bar to return to the Diagnostics menu.  

3. Select OK from the PDA Status Bar to return to the Main menu.  

4. Select Collect Data to return to the Collect Data menu. 

DATA DISPLAY COLORS 

The Data Display Colors menu allows the user to select a specific color for the In-Phase, 

Quadrature, Conductivity and/or Magnetic Susceptibility of the transmit frequencies selected for 

data collection.  

 

Figure 36: Data Display Colors Setup menu. 
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1. To apply a color to a given component, select the desired Frequency number box (F1, F2, 

or F3) of the desired component: In-Phase, Quadrature, Conductivity or Susceptibility, and 

then select the desired color from the color pallet to the right. The selected color will now 

be applied to the selected frequency(s) and component(s).  

2. When you are satisfied with the color(s) select Save Colors > OK from the PDA Status Bar 

to return to the Display Preferences menu.  

DATA DISPLAY LIMITS SETUP Menu 

This menu is used to set the Display Limits for the selected frequencies and components used for 

data collection. To access the Display Scale menu, select Diagnostics > Display Preferences > 

Data Display Limits Setup (Figure 37). 

 

Figure 37: Display Limits menu. 

The Display Scale menu enables the user to select the minimum and maximum data values 

which will be displayed on the screen for the display of Graphic or Alphanumeric data.  

 If a Line or Bar Graph display is selected, the user has the option of selecting a Linear or 

Logarithmic Graphic display scale. The user can enter the desired values for Lower and 

Upper bounds of the data display by selecting in the white values field.  

Units: This parameter displays the distance units selected by the user for survey grid parameters. 

In Figure 38, the Units for the Horizontal Scale are in Feet. The user can select either English or 

Metric units. 

F_STRENGTH (I): The data values for the F_Strength (I) is in parts per million (ppm). 

F_STRENGTH (Q): The data values for the F_Strength (I) is in parts per million (ppm). 

CONDUCT. (mS/m): The data values for the Conductivity are displayed in MilliSiemens per 

meter (mS/m) at 15 kHz. 

Susceptibility: The data values for the magnetic Susceptibility are displayed in milli S.I. 

Horizontal Scale: This will adjust the full-scale width of the Line Graph display to a value 

selected by the user. All Line Graph data is plotted from left to right on the line graph display. 

For example, the user is profiling on the X-axis (X min=0, X max=100) and the horizontal scale 
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was set to 100, the full width of the display would be used to display the entire 100 feet of data. 

At this scale, small features may be compressed and difficult to distinguish. The user could, 

however, select a smaller scale of 10, 20, or 50 feet and the horizontal scale of the display would 

then correspond to the specified distance in feet (in the stationary mode) or the reading number 

(in the continuous mode). The screen will automatically scroll one-half the display width when 

the plotted line graph data reaches the right hand edge of the data display. 

SCALE TYPE: This parameter allows the user to change the data display scale from Linear to 

Logarithmic. 

Note: It is often useful to collect a dummy transect across the site after the instrument has been 

calibrated and the In-Phase zeroed in order to ascertain the range of measured values at the site. 

This allows the user to set the lower and upper bounds so that high positive and negative values 

for the In-Phase and Quadrature data are not clipped off the top or bottom of the display. If, 

during the course of collecting the dummy transect, the user notes that the data is being clipped 

on the display, we recommend that the Lower and Upper bounds on the Graphic display be reset, 

or the scale of the Graphic display set to a Logarithmic scale. The values entered for Lower and 

Upper bounds are for display purposes only. These values do not affect the data values stored in 

memory by the unit during data collection. Once the desired Graphic scale and values for the 

Lower and Upper bounds are entered, select OK from the PDA Status Bar to return to the Data 

Collection menu. 

MAP SMOOTHING 

The Map Smoothing acts to smooth the level contours on the contour map display in the Review 

Data section of the interface (see Section 3.4 Review Data).  

DATA SMOOTHING 

The Data Smoothing filter is a 5 point center-weighted triangular filter that is applied to the data 

during data collection. The user has the option to enable or disable this function. To ensure 

badass data quality, GSSI recommends that this filter remain enabled. 
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SYSTEM SETUP Menu 

The System Setup menu contains all of the entry fields required for system data storage, the 

system metronome beeper, to enable the WAAS GPS function and to conduct the GPS test: To 

access this menu, select Main > Diagnostics > System Setup. 

 

 Save Data (page 29) 

 Beep (page 29) 

 GPS Test (page 29) 

 GPS Device (page 31) 

 GPS Baudrate (page 31) 

 Bluetooth Port (page 31) 

 

 

 

 

Figure 38: System Setup menu. 

SAVE DATA 

The EMP-400 Save Data power on default is ON. 

 If the user wishes to collect data files for test purposes (e.g., evaluating system response and 

for setting the data display limits) and does not wish to save the data, the user can turn Save 

Data Off by selecting this option. This field will toggle between ON (X) and OFF. 

 If the user turns the Save Data Off, the user must remember to turn Save Data On prior to 

collecting data for a survey. If the user turns Off the PDA and the EMP-400 and the Save 

Data has been left Off, the system will power on with the Save Data Off. The user must 

remember to turn On the Save Data before conducting a survey. 

BEEP 

The Beep function power on default is On. It is recommended that the user leave the beep On at 

all times. The Beeper serves several useful functions: 

 It notifies the user when a data point has been collected. 

 In the Continuous (timer) mode, the beep serves as a useful pace timer when collecting 

data. 

GPS TEST 

If the WAAS GPS or an external high-resolution GPS is to be used to collect GPS data, the user 

must conduct a GPS Test. Selecting GPS Test will open the GPS Test display. 
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The only user selectable field on the GPS Test display is the GPS Validity setting. This is 

discussed in detail below. 

GPS Test Messages 

GPS STATUS: Valid/Invalid: GPS validity is determined by the number of satellites and/or the 

HDOP (Horizontal Dilution of Precision). The user selects the number of visible satellites as the 

criteria for determining GPS validity. In this case, the number of satellites should be  four. The 

VALIDITY selections available to the user are: 

 Satellites ≥ 4: If the number of satellites equal to or greater than four, the GPS solution is 

valid. This is the recommended setting for both the WAAS and external GPS validity. 

 Satellites≥ 3: If the number of satellites is equal to or greater than three, the GPS solution is 

valid. 

 HDOP < 2: If the HDOP is less than two (2) the GPS solution is valid. 

 No Conditions: When no conditions are applied to the Validity the GPS is always valid. 

This setting is not recommended. 

LATITUDE: This field displays the GPS calculated Latitude. 

LONGITUDE: This field displays the GPS calculated Longitude.  

GPS UTC: GPS Coordinated Universal Time.  

# Satellites: The number of satellites from which the GPS system is currently receiving a signal. 

HDOP: The Horizontal Dilution of Precision (HDOP) allows one to estimate the accuracy of 

GPS horizontal (latitude/longitude) position fixes by adjusting the error estimates according to 

the geometry of the satellites used. Theoretically, given the HDOP, one can obtain error 

estimates that are good for all fixes with that HDOP, rather than the more general error estimates 

for all position fixes (regardless of HDOP). In probability terminology, HDOP is an additional 

variable that allows one to replace the overall accuracy estimates with conditional accuracy 

estimates for the given HDOP value.  

Note: Prior to conducting a survey using GPS, it is highly recommended that you consult a 

mission planner to determine satellite coverage and visibility at the location where you will be 

conducting the survey. A free QuickPlan program is available from TRIMBLE . It can be 

downloaded from the following URL: www.trimble.com/support_trl.asp?NAV=Collection-3627 

(See also Appendix A). This program contains complete instructions on its use and the URL 

above can be visited regularly to download updated GPS almanacs which contain position 

corrections for GPS satellites. Almanacs should be downloaded regularly to assure you have the 

most recent updated GPS satellite data.  

Note: The average cold-start time for the WAAS GPS is approximately 5 minutes. In some areas 

signal acquisition for the WAAS may be difficult. It is advisable when using the WAAS GPS to 

allow 10-15 minutes for the WAAS to acquire a signal and to establish a stable fix before 

beginning the survey. 

http://www.trimble.com/support_trl.asp?NAV=Collection-3627
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Figure 39: GPS Test menu. 

GPS DEVICE 

The appropriate WAAS communications port for the RECON-400 PDA and EMP-400 

communications have been preset at the factory.  

 The default setting for the WAAS GPS comm. Port is Internal. 

 The default setting for an external GPS comm. port is External. 

Settings for an External GPS System 

The Profiler is designed to accept a NMEA $GPGGA string (see Appendix A for an example of 

a GGA string). If the Profiler is to be configured with an external GPS or DGPS, the GPS system 

output format should be configured as follows: 

 8 bits 

 N (No) parity 

 1 (stop bit) 

 BAUD: 4800/9600 

 The data output rate from an external GPS should be set to as close as possible to the 

data acquisition rate of the EMP-400. In the Continuous mode the operator should set 

the Interval to the same rate as the GPR output. In some cases, the data acquisition 

rate will be higher than the data output rate from the external GPS. 

GPS BAUDRATE 

This setting only applies when using an external GPS device. This value toggles between 4800 

and 9600.  

BLUETOOTH COM PORT 

The Bluetooth communications port cannot be changed or disabled by the user.  
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2.3 Check System Parameters 

The Select Parameters menu contains all of the entry fields for user selectable data acquisition 

parameters: To access this menu, select Main > Select Parameters. 

SELECT PARAMETERS Menu 

 MODE (page 32) 

 INTERVAL (page 32) 

 FREQ 1 (page 33) 

 FREQ 2 (page 33) 

 FREQ 3 (page 33) 

 ORIENTATION (page 34) 

 STACKING (page 35) 

 Use Zero Level for In-Phase (page 39) 

 

Figure 40: Select Parameters menu. 

MODE 

This enables Continuous (time) or Stationary (point-to-point) data collection. Select either 

Continuous or Stationary mode. The selection field will toggle between these two options. 

Continuous Mode: This parameter allows the user to collect data in a timed manner. When 

collecting one (1) frequency the maximum data collection rate is 0.25 sec. When collecting two 

(2) frequencies the maximum data collection rate is 0.5 sec. When collecting three (3) 

frequencies the maximum data collection rate is 1 sec. 

 In Continuous mode, data collection is initiated by selecting Start Data Collection, then 

depressing the Enter ( ) key on the RECON PDA keypad (Figure 8), or by depressing the 

Start button on the RF key fob (Figure 16). The system will beep and the Blue 

communication status lights will blink when the data has been recorded and a data point 

will appear on the PDA data display in the data display format selected by the user. The rate 

at which the EMP-400 will collect Continuous data is selected in the Interval field. 

Stationary Mode: In stationary mode, data collection is initiated by selecting Start Data 

Collection, then depressing the Enter ( ) key on the PDA keypad, or by depressing the Start 

button on the RF key fob. The system will beep and the Blue communication status lights will 

blink when the data has been recorded and a data point will appear on the PDA data display in 

the data display format selected by the user.  

INTERVAL 

Interval is the time interval in seconds between successive readings when operating in the 

Continuous mode. If you are collecting data in the Continuous mode, select the desired time 
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Interval (Figure 41). When you are satisfied with the selection, select OK from the PDA Status 

Bar to return to the Select Parameters screen. 

 

Figure 41: Time Interval menu. 

FREQ 1 

The first transmit frequency.  

FREQ 2 

The second transmit frequency.  

FREQ 3 

The third transmit frequency.  

To Select Frequency 

The user can select from one (1) to three (3) frequencies for data collection. At least one (1) 

frequency must be selected prior to data collection. 

1. Select FREQ 1 from the Select Parameters menu. Figure 42 illustrates the transmit 

frequency selection list Select Frequency menu below. 
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Figure 42: Select Transmit Frequencies menu. 

2. After selecting the transmit frequency(ies), tap OK on the PDA Status Bar to return to the 

Select Parameters screen. 

 In order to collect data with the EMP-400 at least one frequency must be selected. 

 If the user selects more than one (1) transmit frequency for data collection, the user must 

select the frequencies in numerical order, i.e., FREQ 2, FREQ 3. 

 To deselect multiple transmit frequencies i.e., FREQ 2 and/or FREQ 3, the user must select 

FREQ 3 first and then tap None on the Select Frequency list and then tap OK on the PDA 

Status Bar menu. This sequence is then repeated with FREQ 2. 

ORIENTATION 

This parameter writes the orientation of the transmitter and receiver dipoles used during data 

collection into the EMP-400 file header. In the Vertical Dipole Mode (VDM) and the Horizontal 

Dipole Mode (HDM) both the in-line and broadside instrument orientations may be selected. The 

diagram shown in this menu is a birds-eye view of an operator holding the EMP-400. 

 

Figure 43: Dipole Orientation menu. 
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There are four (4) possible dipole orientations: 

 On the left of the screen is the Vertical Dipole Mode. The two instrument orientations are 

VDM broadside (top left) and VDM inline (bottom left).  

 On the right of the screen is the Horizontal Dipole Mode. The instrument orientations are 

HDM broadside (top right) and HDM inline (bottom right).  

After selecting the desired instrument orientation, tap OK on the PDA Status Bar to return to the 

Select Parameters screen.  

Profiler Tilt Error Message 

The EMP-400 electronics incorporates a tilt sensor, which senses the system orientation of the 

instrument with respect to system horizontal i.e., the Vertical Dipole Mode. This sensor will 

detect if the instrument is rotated 90  i.e., to the Horizontal Dipole Mode.  

 For example, if the user selects the Vertical Dipole Mode in the Orientation menu and then 

rotates the EMP-400 90 , the PDA will display a “Profiler Tilt Error” message (Figure 44).  

 If the user selects the Horizontal Dipole Mode in the Orientation menu and then rotates the 

EMP-400 90 , the PDA will display a “Profiler Tilt Error” message Figure 44).  

 If the instrument is in the Vertical Dipole mode and is rotated 180  e.g., upside down, the 

system will display a “Profiler Tilt Error” (Figure 44).  

 The tilt sensor does NOT affect the Orientation setting selected by the user, or the value for 

the instrument orientation that is stored in the file header. The user must enter the correct 

instrument orientation in the Orientation Parameters menu. If the tilt sensor detects an 

orientation error and the error is not corrected in the Orientation menu, the system will 

write an X into the Tilt column of the data file. 

 

Figure 44: Profiler Tilt error. 

STACKING 

The Stacking function will operate in both the Continuous and Stationary modes. Stacking is the 

number of successive readings summed at each data collection point.  
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In the Continuous mode the stacking values are selected automatically. The EMP-400 tries to 

maximize the number of stacks. The total number of stacks is a function of the number of 

frequencies and the speed of operation. For example, if the operator is collecting three (3) 

frequencies at the maximum rate of one (1) reading per second, the Stacking is automatically set 

to 2. If the operator is collecting one frequency at one (1) reading per second, the Stacking is 

automatically set to 8. If the operator is collecting one (1) frequency at 4 reading per second, the 

Stacking is automatically set to 1. 

In the Stationary mode the user selected values are one (1) (no stacking) through 64. If stacked 

data is to be acquired, select Stacking from the Select Parameters menu. The selection field will 

increment through the available stacking values.  

 In the Continuous mode the number of stacks is selected automatically and is a function of 

the number of transmit frequencies and the time interval selected by the user. 

 Stacking is used to suppress random cultural noise and improve the signal-to-noise ratio of 

the data. Stacking is useful in areas where random noise, cultural noise or intermittent noise 

„spikes‟ may be affecting the quality of the data. 

 Stacking will slow down the data acquisition speed. The absolute decrease in collection 

speed will be determined by the number of frequencies collected and the number of stacks.  

 In Stationary mode, the user can increment (increase) the stacking value by tapping the 

right (+) side of the yellow Stacking field. To decrease the Stacking value, tap the left side 

(-) of the Stacking field (Figure 45).  

 

Figure 45:  Increase or decrease Sationary mode Stacking. 

 Once the desired level of stacking is set, tap OK on the PDA Status Bar to return to the 

Main menu. 
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2.4 System Calibrations 

Prior to data collection, the Profiler must be calibrated for the local site condition(s) and to 

compensate for the presence of the operator, the PDA as well as the presence of an external GPS 

system if one is to be used during data collection. The Field Calibration must be performed first, 

and then the Operator Calibration. 

1. To perform the System Calibrations, select the Main > Diagnostics > System Calibrations 

(Figure 46). 

 

Figure 46: Diagnostics Menu. 

 

Figure 47: System Calibrations menu. 

Field Calibration 

1. Prior to performing the Field Calibration, make certain that you have selected the desired 

Transmit Frequencies (Figure 42). 

2. Remove the PDA from the EMP-400 if using the PDA mount. 

3. Place the EMP-400 unit on the ground.  



Geophysical Survey Systems, Inc. Profiler EMP-400 
 User’s Manual 

MN37-230 Rev- 38 

 If the low-carry handle is to be used for data collection, this should already be attached. 

 If the operator is using the hip-height carry strap, this should already be attached. 

4. Walk 12 feet away from the EMP-400 with the PDA. The operator should not interpose 

their body between the PDA and the EMP-400 during the calibration process, or Bluetooth 

communication may be lost. 

5. Select Field Calibration (Figure 48). 

 

Figure 48: Field Calibration menu. 

6. The EMP-400 will begin to calibrate for the selected Transmit frequencies. When the Field 

Calibration is complete, the display will prompt Done (Figure 49). 

 

Figure 49: Completed Field Calibration. 

Operator Calibration 

Note: The operator should remove all other metallic objects from their person. If using an 

external GPS, it is necessary for the operator to carry/wear the GPS while performing the 

Operator Calibration.  
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1. Return to the EMP-400. 

2. Enter the Height (in feet or meters) at which the survey data will be collected. 

 Whether using the low-carry handle or the hip-height carry strap, measure the distance from 

the coils to the ground surface. This measurement must be made with the coils in the 

orientation in which data is to be collected. 

3. Pick up the EMP-400 and position it at the height at which data will be collected. 

4. Select Operator Calibration. 

5. The EMP-400 will begin to calibrate for the selected Transmit frequencies. When the 

Operator Calibration is complete, the display will prompt Done (Figure 50). 

 

Figure 50: Completed Operator Calibration. 

6. System calibration is now complete. 

Note: The EMP-400 System Calibration only calibrates for the currently selected Transmit 

Frequencies. If the operator changes the Transmit Frequencies after the initial calibration, it will 

be necessary to re-calibrate the system for the new Transmit Frequencies. 

Use Zero Level for In-Phase 

This function performs a zero level adjustment of the In-Phase components of the selected 

frequencies to remove any In-Phase signal offset. The zero level values are set for display 

purposes only. The data is recorded and stored in raw form. The values used to zero the data in 

the field are saved in the file header. 

 The acquired In-Phase data is stored with the raw In-Phase component values.  

 The user can also set the line-frequency filter for either 60 Hz or 50 Hz line noise.  

 The zero level setting is performed only after the operating frequencies and line frequency 

filter have been selected by the user and the Field and Operator Calibrations have been 

performed. 

 The Quadrature component values are not zeroed prior to data acquisition. 
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Figure 51: In-Phase Zero Level and Line Filter menu. 

The user should set the In-Phase zero levels in an area where they are confident they are not in 

proximity to buried ferrous metal or near metallic surface objects. The user should be holding the 

instrument at the height at which data will be collected i.e., either with the shoulder strap or 

low-carry handle. The user should remove all metallic objects from their person prior to setting 

the zero levels.  

The EMP-400 has been designed to identify noisy line frequency bands. The Line Frequency 

selection enables either the 50 Hz or 60 Hz line frequency filter. The user should select the 

appropriate line frequency filter setting for the region in which they are operating e.g., in the 

U.S. the filter setting should be 60 Hz; in Japan and Europe this filter setting should be set to 

50 Hz.  

Set In-Phase Zero 

1. Select Zero Level > Set In-Phase Zero. 

2. The EMP-400 will begin to beep and the Blue communication status lights on the EMP-400 

will begin to flash. The user will see a series of numbers displayed for the each of the 

selected transmit frequencies.  

3. The values for the selected frequencies will begin to rise or fall depending upon the 

frequency selected. The Set In-Phase Zero display field will now change to Finish. 

4. The user should wait approximately 10-20 seconds for the values to stabilize, i.e., the 

change in In-Phase values will decrease. 

5. After the In-Phase signals have stabilized, select Finish, then select Set.  

6. Tap OK on the Status Bar to return to Select Parameters menu.  

7. The user should then select the Use Zero Level box. A black X will appear in the box 

indicating that the displayed In-Phase components will have the set zero level values 

applied. 
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2.5 Select Grid Configuration (Grid Config.) 

GRID CONFIG Menu 

The Grid Config menu (Figure 52) contains all of the entry fields for user selectable grid 

configuration parameters including the coordinates for the survey limits, the distance between 

instrument readings and the spacing between successive survey transects. To access this menu, 

select Main > Grid Config. 

 XMIN (page 41) 

 XMAX (page 41) 

 YMIN (page 42) 

 YMAX (page 42) 

 STEP (page 42) 

 SPACING (page 42) 

 MARK SPACING (page 42) 

 GRID TYPE (page 43) 

 DIRECTION (page 44) 

 UNITS (page 45) 

Figure 52: Grid Configuration menu. 

Setting Grid Config – Set Units 

The user must select the survey units in the Project Parameters menu prior to setting the Grid 

Parameters. If the user sets the Units to METRIC, then sets the Grid Parameters, and then resets 

the Units to ENGLISH in the Project Parameters menu, the Grid Parameter units will contain 

conversion rounding errors. At this point the user would have to re-enter the correct Grid 

Parameter values prior to collecting data. 

 All survey grid parameters can be selected by selecting the white value field next to each 

parameter. This will cause the PDA on-screen keyboard to pop-up at the bottom of the 

menu display.  

 To enter numeric information, select the numeric keypad function on the keyboard by 

selecting the 123 box on the upper left corner of the keyboard. The numeric keypad has 

large keys, and it will facilitate entering in numeric values in the Grid Config menu. 

XMIN 

The minimum coordinate for the X-axis. This value can be negative or positive. 

XMAX 

The maximum coordinate for the X-axis. This value can be negative or positive. 
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YMIN 

The minimum coordinate for the y-axis. This value can be negative or positive. 

YMAX 

The maximum coordinate for the Y-axis. This value can be negative or positive. 

STEP 

Stationary Mode: This parameter is the actual distance interval between successive instrument 

readings. 

Continuous Mode: This parameter is the relative distance between successive instrument 

readings. The distance between steps in the Continuous mode is a function of the data acquisition 

rate (Interval setting) of the instrument, and the speed at which the instrument is moved over the 

surface.  

 The maximum positive value for Step cannot exceed the maximum X or Y transect value.  

 The value for Step must always be positive. 

 Fractional values for the Step, i.e., 0.5, can be entered by the operator. If fractional values 

are used, the Step (station) number will increment at the value selected. 

Note: It is strongly recommended that only whole number values (1, 2, 3, etc.) or even fractional 

values (0.25, 0.5, 1.25) be used for the Step value. If any other values are used, the maximum 

transect value (X Max or Y Max) will be rounded down.  

 Example, the grid coordinates entered by the user are Y Min=0, X Min=0, Y Max=50 and 

X Max=50. The user enters a value of 0.75 for the Step, the X Max value will automatically 

be rounded down to 49.50 by the system when the user exits the Grid Config menu. This 

applies for any multiple of .75 (1.5), which results in a repeating decimal fraction if divided 

into 50.  

SPACING 

The distance interval between successive transects of the survey grid. The value entered for 

Spacing must be positive. When data is collected in Stationary mode this is the actual (desired) 

station spacing. When data is collected in Continuous mode this is (essentially) an estimate. We 

recommend that when collecting data in the Continuous mode that the user conducts a test 

transect to determine how many actual readings are acquired for a particular data rate and user 

„pace‟ along a transect. The user can then adjust the Spacing value that more closely reflects the 

actual distance between readings. 

Note: As with Step (see example above), fractional values for the Spacing, i.e., 0.5, can be 

entered by the operator. If fractional values are used, the Spacing number (transect separation) 

will increment at the value selected. Values for the Spacing that divide into the transect 

maximum (X or Y) and yield a result that is a repeating decimal will be rounded down. 

MARK SPACING 

The distance (in Feet or Meters) between fiducial marks placed in the data file when data is 

collected in Continuous mode. 
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Note: If the user is placing fiducial marks in the data, the user must be sure that the value entered 

into the Mark Spacing field is the actual distance at which marks are entered during data 

collection. MagMap 2000 uses these fiducial marks for linear interpolation of continuously 

collected data. If the value entered for Mark Spacing is incorrect, MagMap will interpolate the 

transect distances and the distances between the fiducial marks incorrectly. The user will then 

have to use the line start/end and mark editing functions in MagMap to input the correct distance 

between the marks and correct the overall length of the survey transects (see MagMap 2000 

manual, Chapter 4: Editing of the Map). 

Grid Scaling, Max Grid Size 

The Profiler Grid Config menu is designed to accommodate the scaling of the on-screen Position 

display that is available to the user during data collection. This scaling requires that a formula be 

used to determine what the maximum grid limits for the Continuous or Stationary modes are. 

The formula used is as follows: 

Stationary Mode: 

Stationary = N x M = 500,000 readings.  

Where: 

N = X range/Step +1 

M = Y range/Spacing +1 

Where: 

X range = X min to X max 

Y range = Y min to Y max 

500,000 is the maximum number of stations or data points in a grid area in Stationary mode. 

Continuous Mode: 

Continuous = N x M = 398,161 

Where: 

N = X range/Step +1 

M = Y range/Spacing +1 

Where: 

X range = X min to X max 

Y range = Y min to Y max 

398,161 is the maximum number of stations or data points in a grid area in Continuous mode.  

GRID TYPE 

The small square box on the Grid Type icon indicates the starting point (origin location) of your 

survey. For example, select X Traverse > Grid Type. Figure 53 illustrates the X Traverse, 

X Grid Types below. 
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Figure 53: Select Grid Type (X) menu. 

DIRECTION 

The system will toggle between X Traverse and Y Traverse. The traverse direction indicates the 

orientation of your survey along the X or Y axis.  

 If X Traverse is selected, the Grid Type field will display an icon indicating a traverse type 

oriented along the X (east-west) axis.  

 If Y Traverse is selected, the Grid Type field will display an icon indicating a traverse 

oriented along the Y (north-south) axis.  

This menu displays all the possible X-axis survey transect directions available to the user. The 

label convention is as follows 

 xLB: X-axis profiling starting at the left bottom (LB) corner of the survey grid with all 

transects proceeding in the same direction (unidirectional).  

 xLBZ: X-axis profiling starting in the left bottom (LB) corner of the survey grid with lines 

collected in a zigzag (Z) fashion (bidirectional).  

 All of the icons on the left of the display are for surveys conducted in one (1) direction.  

 All of the icons on the right of the display are surveys conducted in a zigzag manner. For 

example xRBZ indicates X profiling conducted in zigzag (Z) fashion starting from the right 

bottom (RB) of the survey grid.  

 After selecting the appropriate icon, tap OK on the PDA Status Bar to return to the Grid 

Setup menu.  

 To conduct profiling in the Y direction, select Direction for Y Traverse and Grid Type. 

Figure 54 illustrates the Y Traverse, Y Grid Types. 
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Figure 54: Select Grid Type (Y) menu. 

This menu displays all the possible Y-axis survey transect directions available to the user. The 

label convention is as follows:  

 yLB: Y-axis profiling, starting at the left bottom (LB) corner of the survey grid 

(unidirectional).  

 yLBZ: Y-axis profiling starting in the left bottom (LB) corner of the survey grid with lines 

collected in a zigzag (Z) fashion (bidirectional).  

 All of the icons on the left of the display are for surveys conducted in one (1) direction.  

 All of the icons on the right of the display are surveys conducted in a zigzag direction. For 

example, yRBZ indicates Y-axis profiling conducted in zigzag (Z) fashion starting from the 

right bottom (RB) of the survey grid.  

 After selecting the appropriate grid type icon, select OK from the PDA Status Bar to return 

to the Grid Config menu. 

Units 

This field displays the linear units that will be used in the Grid Config menu for XMIN, XMAX 

and YMIN and YMAX grid limit values and the transect Spacing. This field will toggle between 

English and Metric units. (See Setting Grid Config, page 39). 

2.6 Review Parameters 

PROJECT INFO Menu 

Prior to starting the survey, it is often useful to record project information for permanent record 

as well as book keeping purposes. Figure 55 illustrates the Project Info menu. Site metadata 

often includes a Project name which may consist of a site location or job number. In addition, the 

identity of the operator, the date and time when the data was collected and the units (English or 

Metric) are all useful information to archive. This information may be entered into the PDA by 

selecting Main > Review Parameters.  
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 PROJECT (page 45) 

 SITE (page 45) 

 OPERATOR (page 45) 

 NEXT FILE (page 45) 

 DATE(page 46) 

 UNITS (page 46) 

 PROJECT PARAMETERS (page 46) 

 

 

Figure 55: Project Information menu. 

The following fields are available to the user for entering project specific information. This 

information will be saved in the Project file header when the data is written to memory. 

Information can be entered into these fields by using the PDA stylus and selecting the white 

value fields. This will enable the pop-up user keypad. 

PROJECT 

This field can contain alphanumeric information regarding the specific survey being conducted, 

such as the job number or project name. This information will be used to create a Project folder 

into which all data files will be written. This field can contain a maximum of 21 characters. 

SITE 

This field can contain alphanumeric information on the job site or location. This field can contain 

a maximum of 21 characters. 

OPERATOR 

This field can contain alphanumeric information on the system operator. This field can contain a 

maximum of 21 characters. 

NEXT FILE 

This field contains the alphanumeric information on the number of the next data file to be 

collected. The default data file names are written in the form EMP400___001.EMI. The file 

name format can be changed by the operator. The file number field starting at file 001 will 

increment by one (1) with each new file saved by the operator. 

EMI files are stored as BINARY files in the PDA. They are converted to ASCII text files upon 

data transfer from the PDA. 

Note: The number field of the default file names will continue to increment until manually reset 

or changed by the user. The file number field does not automatically reset when the EMP-400 is 

turned off or data is transferred from the PDA by the user. 
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User-Defined File Naming Convention: ******  

DATE 

This field displays the date and time. This field is NOT updated automatically. Prior to beginning 

data collection, the user must select the Date field. This will update the date and time to its 

(current) correct value. 

UNITS 

This field displays the linear units that will be used in the Grid Config menu for XMIN, XMAX 

and YMIN and YMAX grid limit values, as well as the reading Step (in the Stationary mode 

only) and the transect Spacing. This field will toggle between English and Metric units. When 

the desired Grid Config has been entered, tap OK to return to the Review Parameters menu. (See 

Setting Grid Config, page 39). 

PROJECT PARAMETERS Menu 

To access the Project Parameters, select Review Parameters > Project Parameters (Figure 56). 

 

Figure 56: Project Parameters menu. 

The Project Parameters screen displays ALL of the data acquisition parameters as well as the 

Grid Configuration parameters selected by the user.  

 The Select Parameters menu can be accessed directly from this menu by selecting any of 

the Frequency, Mode, Interval, or Orientation fields. This allows the user to quickly change 

any acquisition parameters if survey requirements or site conditions change.  

 The Grid Config menu can be accessed directly from this menu by selecting the Grid Type, 

X Coordinates, Y Coordinates, Traverse Step or Line Spacing. 

2.7 Save Setup 

1. Once all acquisition parameters have been selected, information on the survey parameters 

and grid configuration can be saved for easy recall. To escape from the Select Parameters 

menu tap OK on the PDA Status Bar to accept the current data acquisition parameters.  
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2. The data acquisition setup can be saved by selecting Main > Save Setup. Select Save 

Setup.  

 

Figure 57: Save Setup menu. 

3. The user must select a Setup Number location. There are thirty (30) memory locations 

available to the user to save survey setup parameters. To select a Survey memory location, 

simply tap on the Survey number and then tap OK on the PDA Status Bar to return to the 

Main menu. 
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Chapter 3: Collecting Data 

3.1 Set Data Display Parameters 

COLLECT DATA Menu 

The fields in the Collect Data menu allow you to enter the data display parameters of your 

survey (Figure 58). This menu is accessed by selecting Main > Collect Data. 

 

 F_STRENGTH (I) (page 49) 

 F_STRENGTH (Q) (page 49) 

 CONDUCTIVITY (page 49) 

 ALPHANUMERIC DISPLAY (page 49) 

 GRAPHICS (page 50) 

 DATA DISPLAY LIMITS SETUP (page 27) 

 START DATA COLLECTION (page 50) 

 

 

Figure 58: Collect Data Run Time menu. 

F_STRENGTH (I) 

The magnitude of the In-Phase component of the secondary field. Values are displayed in PPM 

(Parts per Million). This may value may be displayed simultaneously with F_Strength (Q). 

F_STRENGTH (Q) 

The magnitude of the quadrature component of the secondary field. Values are displayed in PPM 

(Parts Per Million). This value may be displayed simultaneously with F_Strength (I). 

CONDUCTIVITY 

When displaying the apparent conductivity, both the F_Strength (I) & F_Strength (Q) displays 

are disabled. When Conductivity is selected, the system will display only the apparent 

conductivity ( a). The correct apparent Conductivity can only be displayed if the user has 

selected 15 kHz as one of the transmit frequencies. 

ALPHANUMERIC DISPLAY 

If Alphanumeric is selected, the numeric values of the selected components will be displayed.  
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GRAPHICS 

The Graphics field allows the user to select a Bar Graph or Line Graph display mode. If None is 

selected, the data will be displayed as Alphanumeric values only. When Line Graph or Bar 

Graph is selected, the user has the option of displaying Alphanumeric data as well. Data may be 

displayed in either Linear or Logarithmic scale. 

DATA DISPLAY LIMITS SETUP 

For details on Data Display Limits Setup procedure see page 26, section 2.3. 

START DATA COLLECTION 

When the operator selects Start Data Collection, the EMP-400 will advance to the Data 

Collection Run-Time menu, as detailed below in Section 3.2, Data Collection. 

3.2 Data Collection 

1. After entering the desired Display Parameters, F_Strength (I) and/or F_Strength (Q) or 

Conductivity, select Start Data Collection. The system will now display either the Data or 

the Positioning display (see 2.3 Check System Diagnostics Parameters, Display 

Preferences). 

 

Figure 59: Start Data collection. 

2. When data collection is first initiated, the data display field will remain blank until the user 

presses the Enter button on the PDA keypad, or the Start button on the key fob. The 

system will now begin data collection. This pause before the start of data collection only 

occurs on the first line of a survey. Once the first line has been collected, data collection 

will begin immediately after the user restarts data acquisition with the Continue Data 

Collection command in the Run Time menu (Figure 63). Figure 60 illustrates the Data 

Collection Data display. In this case, the user has selected a Line Graph display along with 

an alphanumeric data display. 
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Figure 60: Line Graph with Alphanumeric data. 

 Note that the In-Phase data for the alphanumeric display is on the left and the Quadrature 

data is on the right. The transmit frequencies are listed in the left-most column starting with 

Freq 1, Freq 2, Freq 3, etc. The transmit frequencies are listed in the sequence in which they 

were entered. In this example, Freq 1 is 10 kHz. The colors selected for the components 

displayed in the line graph display correspond to the colors of the components in the 

alphanumeric display. 

 Figure 61 illustrates a bar graph display with alphanumeric display. As with the line graph 

display, the colors selected for the components displayed in the bar graph display 

correspond to the colors of the components in the alphanumeric display. 

 

Figure 61: Bar Graph with Alphanumeric display. 

Note that the In-Phase data for the bar graph and alphanumeric display is on the left and the 

Quadrature data is on the right. You will note that the In-Phase for 1 kHz data is saturated, as 

well as both the In-Phase and Quadrature for 5 kHz data. In this situation, it may be desirable to 

return to the Data Display Limits Setup to reset the Lower and Upper bounds for the data display 

so that the Bar Graph data display does not saturate, or set the Scale Type to Logarithmic.  
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3. Once data collection is initiated, the user then proceeds along the survey transect. The user 

can toggle between the Data display (above) and the Positioning display (below) by tapping 

with the stylus anywhere in the data display field. 

 If fiducial marks are placed in the data, they will be drawn as red dots on the positioning 

display. Note that in this example some of the mark positions are misaligned or misplaced. 

This is due to the user entering a mark before or after a survey station or at a line end. 

 

Figure 62: Positioning display with fiducial marks indicated. 

 By toggling between the Data Display and the Positioning display, the user can assure that 

data is being collected with the marks in the correct positions and can also evaluate 

differences in line lengths (the samples per transect) when collecting data in the Continuous 

mode.  

Pause Data Collection 

In order to skip a station due to the presence of a surface obstacle, or to skip a transect due to the 

presence of a large surface feature, the user should select OK from the Data display or 

Positioning display, or press OK on the PDA key pad (or depress the RF Start/Stop key fob key 

twice). Data acquisition will be paused, and the Run Time menu will be displayed (Figure 63). 
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Run-Time Menu 

When data collection is paused, the user has the option to: 

 

 ADVANCE TO NEW LINE (page 53) 

 DELETE CURRENT LINE (page 53) 

 SKIP STATION (page 54) 

 DELETE LAST STATION (page 54) 

 CONTINUE DATA COLLECTION (page 54) 

 STOP DATA COLLECTION (page 54) 

 

Figure 63: Run-time menu. 

ADVANCE TO NEW LINE 

If this option is selected, the line counter at the top of the screen would increment/decrement 

depending upon the grid type selected.  

DELETE CURRENT LINE 

If this option is selected, the entire current line would be deleted from memory and the line 

counter and station counter would increment/decrement to its previous value depending upon the 

grid type selected. This process can be repeated to the beginning of the survey. Any deleted lines 

would then have to be surveyed again in the direction specified by the operator in the Grid Type 

menu.  

Note: In order to prevent the inadvertent deletion of survey lines, the EMP-400 software will 

prompt the user with a courtesy check prior to deleting a survey line (Figure 64). 

 

Figure 64: Run-time menu - Delete Line Courtesy Check. 
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SKIP STATION 

If this option is selected, the station counter will increment/decrement with each tap of the PDA 

stylus in this field. This function can be repeated as many times as is necessary, however the 

number of skipped stations cannot exceed the value entered for XMAX or YMAX in the Grid 

Config menu (depending on which type of traverse, X or Y is being collected). 

DELETE LAST STATION 

If this option is selected, the last recorded reading will be deleted from memory. In this instance, 

the station counter would decrement/increment to the previous station (based on the Step setting 

and the Grid type in the Grid Config menu). This function can be repeated, as many times as 

necessary, however the number of deleted stations cannot exceed the value entered for XMIN or 

YMIN in the Grid Config menu. 

CONTINUE DATA COLLECTION 

If this option is selected, the system will continue in data collection mode until data collection is 

paused at the end of the survey transect. 

 As indicated above, data collection can be paused in one of two ways. The user can select 

OK on the PDA keypad or the user can use the RF key fob to pause data collection by 

depressing the Start/Stop key twice.  

 If the current survey line is then terminated by selecting Advance To New Line, the line 

counter at the top of the screen will increment/decrement and the station counter will reset 

to its appropriate start value (depending upon the Transect Spacing, Step Spacing and grid 

type selected in the Grid Config menu). The user would then select Continue Data 

Collection from the Collect Data menu, or depress the RF key fob Start key once.  

 If intermediate survey control points were marked out during the survey grid set up phase, 

and the operator wishes to mark these locations, the operator can use the RF key fob to 

enter fiduciary marks into the data file by depressing the Upper RF key fob button once or 

by pressing the Enter ( ) key on the PDA keypad. 

STOP DATA COLLECTION 

1. Once the survey grid has been collected, the user should do one of the following to stop 

data collection and return the PDA to the Data Collection menu (Figure 65). 

 Select OK from the PDA key pad, or  

 Depress the RF key fob Start/Stop key twice. 
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Figure 65: Run-time menu - Stop Data Collection Courtesy Check. 

2. The EMP-400 software will prompt the user with a courtesy check to ensure that the user 

does wish to terminate data collection (Figure 65). 

 If the user wishes to terminate data collection, tap Yes with the PDA stylus. 

 If the Stop Data Collection key was selected in error, or the user wishes to continue data 

collection, tap No. The user may tap Continue Data Collection.  

3. If Yes was selected by the user to Stop data collection, the Saving Data progress screen will 

be displayed (Figure 66). 

 

Figure 66: Saving Data progress display. 

4. Once the system has completed saving the file, the PDA will sound a tone and the system 

will return to the Main menu. The system software is designed to increment file numbers 

starting from the file number designated in the Next File field in Main >Review Parameters 

> Project Info(Figure 67). (See also: Chapter 3, Section 3.5 and Figure 55: Project 

Information Menu Display). 
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Figure 67: Project Info menu - Next File. 

Note: Under certain conditions the EMP-400 Bluetooth communications may be lost or 

interrupted. When communication is lost during data collection or during the File Save process, 

the system will not automatically increment the File Number to the next file. In such instances, it 

is most important that the user return to the Project Info menu display and select the Next File 

field to increment the next file number.  

The user should check the working directory after a Bluetooth communications interrupt to 

ascertain exactly what file numbers have been saved and what the last saved file number was. If 

this check/correction is not performed, the user may find that there is a break in the file number 

sequence within the working directory e.g. the files may be numbered: EMP400___001, 

EMP400___002, EMP400___003, EMP__005. 

3.3 Data Review 

Review Data Menu 

The Review Data menu (Figure 68) allows the user to review, delete or quick contour data. 

Select Main > Review Data. 

 

 Project (page 57) 

 File (page 57) 

 REVIEW LAST FILE (page 58) 

 REVIEW (page 58) 

 DELETE PROJECTS (page 59) 

 DELETE FILES (page 60) 

 

 

Figure 68: Review Data menu. 
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Project 

The Review Data menu allows the user to display quick contour maps of an entire data grid.  

1. To select the appropriate Project folder, tap Project. The PDA will then display the stored 

project folders (Figure 69).  

 

Figure 69: Select Project Folder menu. 

2. Select the Project in which the file to be reviewed resides. Note: Common.prj is the default 

EMP-400 project directory. Once the desired Project has been selected, the project name 

will appear in the Project field. 

File 

3. The user can then select the desired file(s). Tap File and select the desired file name (Figure 

70) to Review the file. 

 

Figure 70: Select File(s) menu. 
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REVIEW LAST FILE / REVIEW 

4. Once a file has been selected, using either the File, Project>File or Review functions, the 

Select Data Value screen will be displayed (Figure 71). 

 

Figure 71: Select Data Value menu. 

5. From this screen, the operator can select the frequency and the specific component of that 

frequency to be displayed as a contour map. The EMP-400 contouring algorithm is very 

simple and uses a triangular nearest-neighbor method to grid and contour the data. This 

function serves as a quick way to review your acquired data in the field.  

Example: The user can select the transmit frequency, FREQ 1 through FREQ 3, and F_Strength 

for either the In-Phase or Quadrature components, or Conductivity, and then select PLOT. The 

system will now generate a contour plot (Figure 72). 

           

Figure 72: Review Data Contour Plot In-Phase (left), Quadrature (center) and Conductivity (right). 

The user will note that the display provides no contour level information. This display is 

designed to provide the operator with a quick look at the data in the field in order to identify 

possible features of interest. The user can change the contour level colors and contour type by 
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tapping on the display with the PDA stylus. This will switch the display to the Color Map Tables 

menu (Figure 73). 

 

Figure 73: Contour Plot Color Map Table. 

 There are five (5) system defined Color Tables. These are displayed horizontally on Color 

Map Tables menu as five separate color bands: 

 2 - 16-shade color tables (top) 

 1 - 256-shade color table (blue, white, red-middle) 

 1 – 16-shade grayscale (second from bottom) 

 1 – 2560shade grayscale (bottom) 

 Tap on the desired color table and then tap OK from the PDA status bar, the screen will 

switch back to the contour map display and the data will be displayed with the new user-

selected color table.  

 To save the quick contour map as an *.bmp file, tap Save in the bottom right corner of the 

Review Data Contour Plot display. This file will be written into the active Project folder. 

DELETE PROJECTS 

To delete a project folder select Review Data > Delete Projects (Figure 74). The user can delete 

single projects by selecting the box next to the project to be deleted, or the user can Select All 

and all of the projects in the user memory will be deleted. 

Note: Projects can also be deleted by connecting the PDA to your PC via ActiveSync and 

deleting the appropriate Project folder from the Profiler\Data directory. 

Note: There is NO user protection in this menu display. The system will NOT prompt the user 

with a Confirmation Warning when deleting projects. 
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Figure 74: Delete Project(s) menu. 

DELETE FILES 

To delete a file, groups of files or an entire directory of files, select Review Data > Delete Files. 

The Delete File menu display will appear (Figure 75).  

 To delete a single file, select the box next to the file to be deleted, and then tap Delete.  

 To delete groups of files (Figure 75), select the boxes next to the files to be deleted, and 

then tap Delete. 

 To delete all of the files, select Select All, and all of the files in the current working project 

folder will be deleted when Delete is tapped. 

Note: Files can also be deleted by connecting the PDA to your PC via ActiveSync, selecting the 

appropriate Project folder and deleting the appropriate files from the folder. 

Note: There is NO user protection in this menu display. The system will NOT prompt the user 

with a Confirmation Warning when deleting files. 

 

Figure 75: Delete File menu. 
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3.4 Shutting Down the System 

To shut down the data collection interface after you have completed your survey, return to the 

Main menu, and tap OK on the PDA status bar. The system will then display the program exit 

screen (Figure 76). 

 

Figure 76: Profiler Program Exit. 

To escape from the program tap Exit. If you selected OK on the PDA status bar inadvertently, 

while in the Main menu, tap Cancel and the system will return you to the Main menu. 



Geophysical Survey Systems, Inc. Profiler EMP-400 
 User’s Manual 

MN37-230 Rev- 62 



Geophysical Survey Systems, Inc. Profiler EMP-400 
 User’s Manual 

MN37-230 Rev- 63 

Chapter 4: Transferring, Converting and  
Exporting EMP-400 Data 

Once you have collected your EMP-400 data you will need to transfer the files from the PDA to 

your laptop or desktop computer for conversion, editing, formatting and display. The TDS 

RECON-400 PDA utilizes a USB connection and Microsoft  ActiveSync to transfer data to and 

from the PDA. The user must have ActiveSync version 4.1.0 (or higher) installed on your 

computer and/or the Profiler File Transfer Utility program.  

If you do not have ActiveSync installed on your computer, you can download it from the 

following URL: http://www.microsoft.com/windowsmobile/activesync/default.mspx. You 

should also have installed the MagMap2000 software which was supplied with your system. 

Additional 3
rd

 party software such as ArcheoSurveyor, GEOSOFT, or SURFER are commonly 

used for data processing, and the gridding and contouring of EM data. 

4.1 Transferring Data 

1. To transfer data, the user must first connect the USB cable supplied with your EMP-400 to 

the PDA. 

2. The USB cable has a flat “A” type USB connector and a square “B” type connector. The 

square “B” end should be plugged into the USB port on your PDA (Figure 77). 

 

Figure 77: USB “B” connector plugged into PDA USB port. 

3. The user should now plug the flat USB type “A” connector into a free USB port on your PC 

(Figure 78). 

 

Figure 78: USB “A” connector plugged into free PC USB port. 

http://www.microsoft.com/windowsmobile/activesync/default.mspx
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4. Data can be transferred directly from the PDA to your computer via ActiveSync, or you can 

use Profiler File Transfer Program/File Transfer Utility interface. The File Transfer Utility 

interface is designed to access the EMP-400 storage memory.  

Note: It is necessary to install ActiveSync in order for the File Transfer Utility to function 

correctly. 

4.2 Transferring Data Using ActiveSync 

1. Upon connection of your PDA to your computer, you will hear the ActiveSync connection 

tone and the Synchronization Setup Wizard window will appear (Figure 79). 

 

Figure 79: Synchronization Setup Wizard. 

2. As we are not setting up a sync relationship between the PDA and the PC, the user should 

select Cancel. ActiveSync will then connect the PDA and PC and the ActiveSync 

connection window will appear (Figure 80). 

 

Figure 80: ActiveSync Explorer Connection window. 

3. To access the PDA system and memory, select the Explore icon. This will access the 

Mobile Device window (Figure 81). 
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Figure 81: Mobile device window. 

4. The user should now select the My Windows Mobile-Based Device icon. This will access 

the PDA Root directory (Figure 82). 

 

Figure 82: Mobile-device root directory window. 

5. The user should now select the Profiler folder. This will access the Data directory  

(Figure 83). 

Note: Do not access and files or directories in the PDA root directory other than the Profiler file 

folder. Some files in the PDA root directory are required system files or log files. These files 

should not be accessed, moved or deleted from the PDA root directory. GSSI assumes no 

responsibility for the proper operation of the EMP-400 if any of these files have been accessed, 

moved or deleted. 

 

Figure 83: Profiler Data directory window. 
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6. The user should now select the Data folder (Figure 84). This example folder contains the 

following files/folders: Common.prj (the default Project folder) and Setup01.SRV. This file 

and project folders should be moved or deleted by the operator. GSSI assumes no 

responsibility for the proper operation of the EMP-400 if any of these files have been 

accessed, moved or deleted. 

 All project folders, including those created by the user, will be found in the 

PROFILER\Data folder and are identified by the extension *.prj. 

 

Figure 84: Profiler data directory. 

7. If the user has not created a custom project directory, all of the EMP-400 data files will be 

found in the Common directory. Select the COMMON.prj folder. An example of the 

Common project folder contents are illustrated in Figure 85. 

 

Figure 85: Profiler data file types. 

The user will note there are three (3) files types: 

EMP400___00#.dzb – This is a binary bitmap contour map file of the survey grid collected. 

This files is used to create the Review Data contour map. This file can also be displayed in the 

3D Mode in the GSSI GPR data processing program, RADAN™. 

EMP400___00#.EMI – This is the binary data file stored by the EMP-400. It is converted to an 

ASCII text type file upon transfer from the PDA. It may be opened in EXCEL as a comma 

separated variable file (CSV) file. It is suggested that EXCEL be used only to review the .EMI 

data file. If it is necessary to edit the file, GSSI recommends that the file first be converted to an 

*.dat file in the MagMap program. This file can then be opened and edited in MapMap 2000 or 

Surfer. After any edits are made, the operator must remember to save the file as an *.dat file 

type. 
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The *.EMI file is recognized by MagMap2000 as a native file type. MagMap2000 has been 

modified to read the EMP400 file header. MagMap 2000 will automatically perform linear 

interpolation on data collected with the EMP-400 in the Continuous mode. An example 

EMP400___00#.EMI file is illustrated in Figure 86. 

EMP400___00#.GPS – This is the GPS file required by MagMap2000 to integrate the GPS and 

EM data. It is formatted as a standard NMEA GGA string. The can be opened in Excel as a 

comma delimited file. A GPS file is stored by the system if the WAAS GPS is enabled or the 

user has connected an external GPS unit to the PDA (see Section 2.2: Check System Diagnostic 

Parameters). 

Figure 86 is an example of a multi frequency file collected without a GPS system connected to 

the PDA. All of the data acquisition and grid parameter information is written as a header above 

the EMP400/GPS data. The header is separated from the data section of the file by the $$$ signs.  

 

 

Figure 86: Profiler *.EMI data file example. 

Figure 87is an example of a multi frequency file collected with a GPS system connected to the 

PDA via the comm port. All of the data acquisition and grid parameter information is written as a 

header above the EMP400/GPS data. The header is separated from the data section of the file by 

the $$$ signs. The GPS information, latitude, longitude and elevation (ALT), is written inside the 

EMI file. In this example they are found in columns S, T and U. 
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Figure 87: Profiler *.EMI data file with GPS. 

Figure 88 illustrates the standard EMP-400 GPS file. The format of all EMP-400 GPS files are in 

standard NMEA GGA format. 

This file is compatible with the MagMap2000 GPS Conversion and Processing functions. It can 

also be translated to other co-ordinate types by the user with the appropriate formulas in 

Microsoft Excel™. 

 

Figure 88: Profiler GGA *.GPS data file example. 
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The EMP400___00#.dzb file type is a two dimensional binary bitmap. It is used to generate the 

contour map display in the Review Data menu of the EMP-400 PDA (Figure 72). It is also 

compatible with the 3D display of RADAN. 

 

Figure 89: Profiler data files. 

Prior to transferring data to the PC, the user should create a destination folder for the data. Once 

the folder has been created on the PC, the user simply has to use the Windows copy, paste, or 

move functions to copy or move data from the PDA to the destination folder on the PC. 

4.3 Transferring Data Using File Transfer Utility 

Data can also be transferred from the PDA to PC by using the Profiler Transfer Utility. As 

indicated, the File Transfer Utility requires that ActiveSync be installed on the PC and the PDA  

1. The File Transfer Utility can be copied directly from the Accessories CD provided with 

your EMP-400 to your PC desktop. Double-click the File Manager desktop icon. The File 

Manger screen will be displayed (Figure 90). 

 

Figure 90: Profiler File Transfer Utility screen. 



Geophysical Survey Systems, Inc. Profiler EMP-400 
 User’s Manual 

MN37-230 Rev- 70 

2. The File Transfer Utility enables the user to transfer single files, groups of files, entire 

project folders and/or specific file types e.g. binary *.dzb files, ASCII *.EMI files or *.GPS 

files. 

 The Project Transfer button allows the user to transfer complete project folders (*.prj) 

from the PDA to the PC.  

 The File Transfer button allows the user to transfer selected files (*.EMI, *.GPS or 

*.DZB) from the PDA to the PC.  

 The PC Directory button allows the user to select the target directory for the files to be 

transferred from the PDA to the PC. 

3. Once the desired file/project and target directory selections have been made, select 

Transfer Files from PDA To PC. The transferred files will appear in the Files Transferred 

Window. 

4.4 Converting Files in MagMap2000 

The MagMap2000 program is provided with the Profiler EMP-400 for two principal purposes: 

1. To perform linear interpolation of survey line data collected in the Continuous mode, and to 

allow the user to edit survey lines, survey points and marker positions using the grid editing 

commands available in MagMap2000. 

2. To integrate GGA GPS data with EMP-400 data. 

Converting and Exporting EMP-400 EM Files 

Once you have transferred your EMP-400 files to your computer, open MagMap2000 by clicking 

the MagMap2000 icon located on your desktop. The MagMap2000 Main menu is illustrated in 

Figure 91. 

 

Figure 91: MagMap2000 Main menu. 

1. To open an *.EMI file, select the file Open tab from the Main menu. Using the Look In 

Directory search bar, select the directory to which you transferred your EMP-400I files. 
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 Upon first opening the program, the user may have to select the Files of Type box located 

at the bottom of the File Open dialog box, and select the GSSI Profiler (*.EMI) file type. 

The system will now recognize the *.EMI files (Figure 92). 

 

Figure 92: MagMap2000 File Open dialog box. 

2. Once you have selected the *.EMI file type, the File Open dialog box should display a list 

of your EMP-400 *.EMI files. To open a file, select the file with your cursor and click 

Open, or simply double-click on the desired file.  

3. Upon opening the file, the MagMap2000 program will open the GSSI Profiler Information 

display. This is information comprises data stored in the file header (Figure 93). 

 

Figure 93: MagMap2000 GSSI Profiler Header Information Display(NEW). 

4. If you are satisfied that the information in the file header is correct, particularly the 

information on the acquired frequencies, orientation and grid parameters, select OK.  

 If the data was collected in Continuous mode, MagMap2000 will read the information in 

the file header regarding grid origin location, grid type, X and Y origin location, transect 

spacing and mark spacing and will generate an interpolated grid of the collected data. 

 If marks (user or fiducial) are present in the data, MagMap2000 will interpolate between 

the line start mark, the user fiducial marks and the line end mark. 

 It is important that the user has entered the correct value for the Marker Spacing in the Grid 

Config menu. If the user is not placing fiducial marks in the record, the user should enter a 

value for Mark Spacing that is equal to the transect distance in order for MagMap2000 to 
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interpolate the distances between the recorded readings correctly. In the following example 

the data file is an xLBZ grid with X and Y origin at zero, and an X and Y maximum of 50. 

The Step is set to one (1) and the Line Spacing has been set to two (2). The distance 

between the marks has been set at 50 (the line length). This interpolated grid is illustrated in 

Figure 94. 

 

 

Figure 94: MagMap2000 *.EMI File Grid Display. 

In this figure, the green squares correspond to the beginning of each transect, the red squares 

correspond to the end of each transect. The location of each data point is indicated by a dot ( ) 

and the direction in which each transect was collected in is indicated by a > or a < arrow. The 

origin coordinates 0.00, 0.00 and the line end coordinates X = 50.00, Y = 50.00 correspond to the 

grid limits for this example grid. 

5. The file is now ready to be exported. From the MagMap2000 Main menu toolbar, select  

File > Export. This will bring up the Export Setting dialog box (Figure 95). 

 

Figure 95; MagMap2000 File Header display. 

6. The file can currently be exported in SURFER, GEOSOFT, TEXT (Space Delimited) and 

SURFER 3 column (X, Y, Z) data file formats. The converted file will be created and can 

be written back into the directory of your choice by using the Select Output Path/File Name 
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tab. After designating a file name and the target directory for the export file, select Export 

Now. In this example (Figure 95) we have chosen a SURFER*.dat file type. 

7. This interpolated file is now ready to be gridded and contoured. This example data file 

shows interpolated X (position) data in column A and Y (line) data in column B for the 

positions of each data point. Figure 96 illustrates an interpolated and converted SURFER 

*.dat file type. 

 

Figure 96: EMP400 *.EMI File converted to a Surfer *.DAT file. 

4.5: Working with *.EMI and GPS Files in MagMap2000 

The EMP-400 incorporates an integrated 12-channel WAAS GPS receiver for collecting geo-

referenced EM data and can be easily configured with an external GPS or DGPS system via the 

PDA RS-232 interface. 

When data is collected with the GPS enabled, the EMP-400 will create an EMP400___00#.GPS 

file for each data file collected. This file is required by MagMap2000 to integrate GPS and EM 

data. It is formatted as a standard NMEA GGA string. In addition, the EMP-400 will store the 

GPS data in the *.EMI file in Decimal Degrees format. This allows the user to bypass the 

MagMap2000 program and its associated GPS smoothing and editing functions, if desired. 

1. To begin working with your EMP400.EMI and GPS files, open MagMap2000.  

2. Select File and open your EMP400.EMI file. If the GPS was enabled during data collection, 

the MagMap2000 program will „look‟ for an EMP400___00#.GPS file in the same folder 

location as the EMP400.EMI file. 

3. To open an EMP400.EMI file, select the File Open tab from the Main menu. Using the 

Look In Directory search bar, select the directory to which you transferred your 

EMP400.EMI files.  
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4. Upon first opening the program, the user may have to select the Files of Type box in the 

file open dialog box and select the GSSI Profiler (*.EMI) file type before the system will 

recognize the EMP400.EMI files. 

5. Once you have selected the file you wish to process, the MagMap2000 program will open 

the GSSI Profiler Information display. This is information comprises data stored in the file 

header (Figure 97). 

 If the check box “Use GPS to Load the Data” is checked, the program will load the data 

with GGA GPS coordinates in the associated EMP400___00#.GPS file and convert then to 

Decimal Degrees.  

 If the check box “Use GPS to Load Data” is checked and the *.GPS file is not in the same 

location (directory\folder) as the EMP400.EMI file, MagMap2000 will issue a warning, 

“Warning! GPS Status is enabled but no GPS file is available.” The operator may also 

receive this warning if the EMI or GPS file is corrupted in any way. 

 If the check box “Use GPS to Load data” is left unchecked, MagMap2000 will use the grid 

parameter information stored in the file header (Figure 97) to grid the data. 

 

Figure 97: File Open dialogue box. 

6. After selecting “Use GPS positions to load the data,” MagMap 2000 will display the data in 

Decimal Degrees format (Figure 98). The green squares indicate the start coordinate of a 

survey line, and the red squares indicate the end coordinate of a survey line. The blue 

squares indicate reading locations and the black arrows superimposed on the blue squares 

indicate the direction in which the transects were acquired. 

Note: In some cases during the course of an EM survey using GPS, the GPS system may “drop” 

a fix. In the case of a system receiving a DGPS correction signal, in some cases, the GPS system 

may lose signal lock or the update period for the DGPS correction signal may be exceeded. In 

these instances, MagMap 2000 will log the last correct position data, and “drop” the fix at the 

location at which the DGPS correction signal was lost. MagMap 2000 will not plot a fixed 

position ??????? 
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Figure 98: EM\GPS plotted data. 

Converting Decimal Degree Geographic Coordinates to UTM 

There are several functions available for smoothing/transforming the EM/GPS data in 

MagMap2000. 

1. The first function is the UTM transformation (Universal Transverse Mercator). This 

function will transform the GPS decimal degrees geographical coordinates to UTM 

coordinates. Select GPS for the MagMap2000 toolbar, and then select UTM Setup 

(Figure 99). 

 

Figure 99: UTM Setup dialog box. 

2. To convert to UTM coordinates, select the Enable UTM transformation box (Figure 100). 
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Figure 100: UTM Setup dialog box. 

 Enable UTM Transformation: This function allows you to turn the UTM transformation 

on or off. When it is turned off, MagMap2000 will use geographical coordinates. 

MagMap2000 will use the given parameters to calculate UTM parameters when it is 

selected. 

 Ellipsoid Name: This is the type of ellipsoid used to approximate the shape of the earth. 

Since the Earth is not a perfect sphere, some ellipsoids may be closer approximations to the 

region where you have conducted your survey than others. The “standard” ellipsoid is the 

WGS-84 (World Geodetic System). 

 Autoset Projection Parameters: This function is useful when you do not know what the 

prime Meridian you are using is, or when your data lies in an area where your prime 

meridian may change. 

 Prime (Central) Meridian: If you have not selected “Autoset projection parameters”, you 

must fill this value in. This value has a large affect on the UTM coordinates generated due 

to the non-uniformity of a particular ellipsoid. It can be quickly estimated as the value of 

the longitude but you should look it up. The UTM system uses zone code instead of specific 

projections. Each zone has a central meridian. Zone 14, for example, has a central meridian 

of 99 degrees west longitude. The zone extends from 96 to 102 degrees west longitude. The 

table below (adapted from the MagMap 2000 User Guide 24891-01 Rev G) lists the UTM 

zone code as used in the GCTPc projection transformation package. 
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Zone C.M. Range Zone C.M Range  

01 177W 180W-174W 31 003E 00E-006E 

02 171W 174W-168W 32 009E 006E-012E 

03 165W 168W-162W 33 015E 0012E-018E 

04 159W 162W-156W 34 021E 018E-024E 

05 153W 156W-150W 35 027E 024E-030E 

06 147W 150W-144W 36 033E 030E-036E 

07 141W 144W-138W 37 039E 036E-042E 

08 135W 138W-132W 38 045E 042E-048E 

09 129W 132W-126W 39 051E 048E-054E 

10 123W 126W-120W 40 057E 054E-060E 

11 117W 120W-114W 41 063E 060E-066E 

12 111W 114W-108W 42 069E 066E-072E 

13 105W 108W-102W 43 075E 072E-078E 

14 099W 102W-096W 44 081E 078E-084E 

15 093W 096W-090W 45 087E 084E-090E 

16 087W 090W-084W 46 093E 090E-096E 

17 081W 084W-078W 47 099E 096E-102E 

18 075W 078W-072W 48 105E 102E-108E 

19 069W 072W-066W 49 111E 108E-114E 

20 063W 066W-060W 50 117E 114E-120E 

21 057W 060W-054W 51 123E 120E-126E 

22 051W 054W-048W 52 129E 126E-132E 

23 045W 048W-042W 53 135E 132E-138E 

24 039W 042W-036W 54 141E 138E-144E 

25 033W 036W-030W 55 147E 144E-150E 

26 027W 030W-024W 56 153E 150E-156E 

27 021W 024W-018W 57 159E 156E-162E 

28 015W 018W-012W 58 165E 162E-168E 

29 009W 012W-006W 59 171E 168E-174E 

30 003W 006W-000E 60 177E 174E-180W 
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 Northing/Easting: These are constant values that you (usually) add to your UTM 

coordinates. UTM Coordinates are usually large numbers of approximately a million 

meters; however, your survey may be on the order of tens, hundreds or thousands of meters. 

This allows you to simplify your final numbers by adding or subtracting the large offset 

values. 

In most cases it is advisable to let the program automatically set the UTM parameters since an 

incorrect value for the prime meridian can seriously affect how your data will appear on the 

display. 

3. If you are satisfied with the UTM conversion settings, select OK. Figure 101 illustrates the 

data set converted to UTM coordinates. 

 

Figure 101: Decimal Degree data converted to UTM coordinates. 

Smoothing GPS Positions 

The MagMap2000 GPS Smooth Position allows you to smooth your GPS data and eliminates 

spikes in your GPS position data. MagMap2000 uses a smoothing spline of the third degree to 

smooth GPS data. We start with the GPS Position screen illustrated in Figure 102. 

 

Figure 102: GPS Position display. 
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1. After selecting the GPS menu option > Smooth positions, select the GPS Smooth Position 

option from the Main menu and the Line Smoothing Parameters Setup window will be 

displayed (Figure 103). 

 

Figure 103: GPS Line Smoothing Parameters dialog box. 

This dialog box lists all of the lines in your survey (in this example 19). You will also see a 

series of parameters that can be set to manipulate the magnitude and type of smoothing. This 

dialog box allows you to set the smoothing parameters for each line. You can select any of the 

parameters, except Line#, and modify the value. The parameters are: 

Line #: This is the number of the line you wish to smooth. 

Spl. Smooth 1: This allows you to turn the smoothing on or off for any given line. 

Parameter: This controls the degree of smoothing applied to the selected line. The higher the 

value, the greater the degree of smoothing. 

Despike: This allows you to select whether you would like to despike before smoothing. 

Jump: This controls the distance that is considered a “spike.” The smoothing algorithm will 

calculate a smoothing curve. It will then calculate the distance between the smoothed points and 

your original points. If any of these distances are greater than the distance you specified in 

“jump,” the point will be replaced by a point on the smoothed curve. All points falling within the 

“jump” distance of the smoothed curve will be smoothed. All points falling outside the “jump” 

distance of the smoothed curve will be left untouched. 

Note: It is recommended that the operator perform a second smoothing after using the “jump” 

function to despike the curve since the curve is not actually smoothed. The first smoothing spline 

is used only for calculating if a given point is a spike. If you perform smoothing a second time, 

the program will smooth the despiked data. 

Spl. Smooth II: This enables you to turn on a higher degree of smoothing. This will be 

performed after your first despiking and smoothing have been performed. 

Parameter: This controls the degree of smoothing for the second pass smoothing; the higher the 

value, the greater the degree of smoothing. 

The user can also change the parameters for an individual line by selecting the line number and 

then selecting Change Line Parameters. This is illustrated in Figure 104 for Line # 0. 
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Figure 104: Smooth Line Parameters (Line #0). 

In this example, we have changed the first smoothing parameter from four (the default value) to 

six for a higher degree of smoothing. We have also increased the second smoothing parameter to 

four (default value of two). We have also included a position despike with a jump of one meter. 

After selecting OK these changes are reflected in the Line smoothing parameters setup dialog 

box. 

2. To perform the smoothing, select Smooth. If all lines were selected for smoothing, a series 

of yellow lines will be displayed that indicate what your smoothed data will look like if you 

apply the changes. 

Note: No changes are applied to the data until you select Close > Apply. If the results of the 

smoothing operation are unacceptable, you can exit the screen by selecting Close, or you can 

change the smoothing parameters and select Smooth again. 

 

Figure 105: GPS locations as they appear (in blue) and after smoothing and despiking (yellow lines). 

An inspection of Figure 105 shows that some lines are straighter than others. In this example, 

some transects required the operator to walk around obstacles during data collection. However, 

all lines have had the same degree of smoothing applied. 

We could smooth out Line 0 and 1 (top of the map) and Lines 8 and 9 (middle of the map) by 

applying another pass of smoothing with a higher smoothing parameter. Once the user has 

selected Close > Apply, the changes to the GPS positions are permanently applied and cannot be 
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undone. To undo changes to the GPS positions, you would have to reload the original file and re-

smooth the data. 

The smoothed data is illustrated in Figure 106 . 

 

Figure 106: GPS locations, as they appear after 1 pass smoothing and despiking. 

For other tips on smoothing procedures and warnings about smoothing, we refer the user to 

Section 8.5.1 of the MagMap 2000 User Guide. 
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Appendix A: Understanding GPS And WAAS 

GPS - What is it? 

WAAS GPS is a navigation system designed to provide instantaneous position, velocity and time 

information almost anywhere on the globe at any time, and in any weather. It typically provides 

positioning accuracies of approximately 3 meters. Since GPS receivers need to see much of the 

sky, it works poorly indoors, in the woods and in urban and semi-urban areas where nearby 

buildings create GPS signal multi-path problems. 

Why do I need it? 

You probably don‟t. In fact, for many EM applications you can just use a measuring tape and 

stakes or spray paint to measure and mark out your grid and take notes about your site an transect 

start and stop locations. Since post-survey verification digging or drilling often requires more 

precision than 3 meters, knowing approximately where you are is not helpful. However, as 

surveys become larger and as technologies improve, WAAS GPS can be very helpful in telling 

you where you are on a map, or what road you turned onto, or what section of the site you have 

already covered. Increasingly WAAS GPS is claiming a legitimate place in the ever-increasing 

size and variety of geophysical applications. 

How does it work? 

Standard GPS works by three-dimensional trilateration of the distance from a constellation of 

GPS satellites in space. The satellites measure the time is takes a GPS satellite signal to travel 

from one point to another very accurately and then estimate the distance based on the travel-time 

of the signal using the speed of light as the signal velocity. Getting the travel-time calculations 

from just three satellites is enough to know where you approximately are on the earth. Four or 

more satellites are required for higher accuracy. Getting the travel-time from 6 or more satellites 

greatly decreases the uncertainty of your position. Typically, around buildings and trees you 

might “see” six satellites, plenty to know where you are to within 3 meters. The degree of 

precision depends on many things like how well distributed the satellites are in the sky or the 

precise travel path the signal takes to get from the GPS satellites to your GPS receiver. 

Main sources of error 

The GPS signal travel-times and paths are directly affected by the medium through which the 

signals are transmitted. For GPS, this means the signal from the satellites to your receiver can be 

slowed down and bent by changes in the Ionosphere, the Troposphere and nearby objects. These 

sources of error are illustrated in Figure 3.16 . These sources of error can be reduced using 

expensive tricks like dual frequency systems, Klobuchar modeling, and Real Time Kinematic 

(RTK) solutions. The least expensive way to correct for these errors is through Differential GPS 

(DGPS), where data from a second stationary base station GPS is subtracted from a roving GPS 

or in the form of a differential GPS signal coming from a GPS satellite or ground beacon. Such 

differential signals are provide at extra cost through subscription services such as OMNISTAR 

or THALES. Compared to the distance from the satellite, the distance between a base station and 

rover is insignificant, which means that the travel paths through the ionosphere and troposphere 
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are (essentially) identical. The difference between the two positions subtracts out atmospheric 

effects, leaving just the rover position. 
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Figure 107: Main Sources of GPS Error. 

What is WAAS? 

The Wide Area Augmentation System (WAAS) is a form of differential GPS that uses 

geostationary GPS satellites to transmit an error correction estimate back down to your GPS 

receiver. The measured positions of ground reference stations, strategically positioned across the 

country, are transmitted up to the WAAS satellites. Your receiver reads the signal from the 

WAAS reference station closest to you. It uses a combination of specialized WAAS satellites 

and ground-based stations to send correction signals to WAAS GPS receivers, as well as 

providing integrity information for each satellite's signal and is equivalent or better than RAIM 

(Receiver Autonomous Integrity Monitoring), thereby improving the accuracy of the standard 

GPS signal by approximately 5 times.  

The European Geostationary Navigation Overlay System (EGNOS) is the European equivalent 

to this United States system. In Asia, it's the Japanese Multi-Functional Satellite Augmentation 

System (MSAS). The International Civil Aviation Organization (ICAO) calls this type of system 

a Satellite Based Augmentation System (SBAS). A typical WAAS system is illustrated in  

Figure 108 
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Figure 108: GPS Satellites and WAAS Satellite and reference stations. 

WAAS testing in September 2002 confirmed accuracy performance of 1 – 2 meters horizontal 

and 2 –3 meters vertical throughout the majority of the continental U.S. and portions of Alaska. 

(SEE: http://gps.faa.gov/Programs/WAAS/waas.htm).  

What is NMEA? 

The National Marine Electronics Association (NEMA) has generated a standard set of messages 

for communicating GPS information. The EMP-400 uses the NMEA 0183 version 2.1 protocols. 

The EMP-400 WAAS GPS receiver has been configured to send a GGA data or message string 

and the PDA will accept only a GGA message string. No other NMEA strings are supported for 

the Profiler by GSSI. 

http://gps.faa.gov/Programs/WAAS/waas.htm
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Appendix B: Example of GGA Data String 

STRING:  $GPGGA,hhmmss.ss,llll.ll,a,yyyyy.yy,a,x,xx,x.x,x.x,M,x.x,M,x.x,xxxx*hh 

 

GGA = Global Positioning System Fix Data 

1 = UTC of Position 

2 = Latitude 

3 = N or S 

4 = Longitude 

5 = E or W 

6 = GPS quality indicator (0=invalid; 1=GPS fix; 2=Diff. GPS fix) 

7 = Number of satellites in use [not those in view] 

8 = Horizontal dilution of position 

9 = Antenna altitude above/below mean sea level (geoid) 

10 = Meters (Antenna height unit) 

11 = Geoidal separation (Diff. between WGS-84 earth ellipsoid and mean sea level. -=geoid is 

below WGS-84 ellipsoid) 

12 = Meters (Units of geoidal separation) 

13 = Age in seconds since last update from diff. reference station 

14 = Diff. reference station ID# 
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Appendix C: Conducting a Survey 

Prior to conducting any survey, the user should evaluate the objective(s) of the investigation and 

the survey site conditions. The survey objective should be carefully considered, as this will 

determine the frequency(ies) of operation, the mode(s) of instrument operation and the spatial 

sampling density required. The local surficial geology should be investigated in detail, as the on-

site geologic conditions will be a principal factor in determining the effectiveness of the 

induction method. Site conditions such as topography, the presence and proximity of surface 

cultural features and surface vegetation should all be evaluated. These will affect survey 

logistics, data quality, and ultimately the survey results. 

C.1 Survey Planning 

Survey planning can be broken down into two phases. The first phase involves collecting 

information on the site geology, hydrogeology, and the site history, as well as evaluating the 

physical conditions at the site and its suitability for conducting an EM survey. Any site 

conditions which may present obstacles to the efficient collection of high quality data must be 

taken into consideration, or dealt with directly prior to moving on to the second phase, survey 

grid setup.  

EM surveys often have multiple objectives. These may include the detection of buried objects 

such as metallic tanks, drums or buried foundations, the detection and delineation of waste burial 

pits or trenches, the mapping of the surficial soils and/or overburden materials, the detection and 

delineation of contamination plumes in the soil and groundwater or mapping the location and 

extent of geologic or archaeological features. 

If there are multiple survey objectives, it is generally desirable and more cost effective to plan 

the survey coverage so that it will be effective in addressing the most difficult of the survey 

objectives. The required level of survey coverage that will provide adequate information to meet 

the most difficult survey objective will generally be more than sufficient to meet the 

requirements of other secondary goals. The frequency(ies) of operation, spatial sampling density, 

the mode of operation (i.e., the instrument geometry) and, in some cases, the speed at which the 

data is collected, determine the level of survey coverage and measurement precision.  

As we have indicated above, the first phase in survey planning is to acquire as much information 

as possible on the geologic and hydrogeologic conditions of the site. This information should be 

collected from as many sources as possible. These sources could include maps of the surficial 

geology of the area (surficial geology maps of most areas of the US are available from the 

USGS), as well as data from local or on-site well logs, test borings and/or test pits. It is also 

extremely useful to obtain any available reports of previous geologic or geophysical 

investigations that may have been conducted at the site. Publications on the application of EM 

for similar types of surveys should be carefully reviewed. These studies can provide valuable 

insight on data collection methods, data processing and data interpretation. 

In urban and semi-urban areas, collecting data on the land-use history of the site (if possible) is 

also extremely important.  

The review of all available geologic information enables the survey planner to assess the on-site 

geologic conditions and their possible affects on the overall effectiveness of the method, to make 
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estimates of the magnitude of the conductivity contrasts that may be encountered and to make 

estimates of measurement sensitivity and probable depths of exploration (DOE). 

The land-use history data can provide the survey planner with information on the approximate 

location and distribution of extant or historical man-made features. When evaluated within the 

context of the primary survey objective, this information is of primary importance in any 

planning decisions regarding survey grid location, orientation, and transect spacing.  

The topographic variations at the site should also be evaluated during the survey planning stages. 

Significant topographic variation in some geologic settings can have an effect on subsurface 

induction readings. The possible impact of topographic variations on the data should be 

evaluated to determine their possible effects on the measurements. If deemed necessary, 

topographic data should be collected. The contoured topography data can then be compared to 

the induction measurements to ascertain if there is any relationship between topographic 

variation and the measured subsurface conductivity variations. 

The presence and distribution of man-made cultural artifacts on the surface should also be 

evaluated. The presence and location of electrical conductors (e.g., fences, cars, metallic light 

posts, etc) and large structures on the surface will have an adverse effect on the quality of EM 

data. In some cases, it may be necessary to modify survey coverage to avoid the influence of 

these features. It the survey site has areas of significant vegetation, or is completely covered by 

vegetation, it should be cut and removed prior to grid layout and data collection to assure that it 

does not present an obstacle to the operator during the process of data collection. Ideally, the site 

should be cleared to the extent that surface growth would not present an obstacle to the operator 

and the instrument during the continuous collection of data. This assures that an operator can 

maintain a steady, constant walking pace during data collection and maintain steady orientation 

of the instrument. 

C.2 Survey Grid Setup 

Once all available information regarding the site has been collected and evaluated, the 

investigator can proceed to the survey grid setup. Survey grid setup requires the following tools: 

 Survey Tapes – preferably three double-sided tapes with English units on one side and 

Metric Units on the other. 

 Plastic survey flags. 

 Wooden survey stakes. 

 Mallet for driving stakes. 

 Rolls of plastic fluorescent flagging tape. 

 Marking paint, chalk or lumber crayons. 

 A permanent marker for marking survey stations on survey stakes or flags. 

 A field notebook for logging notes on surface features, topography and surface conditions. 

 A quality compass, preferably a survey grade instrument. 
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 A set of ropes with distance intervals marked on them with colored tape, flagging or knots. 

These ropes are very useful, as they allow the investigator to follow a straight, distance-

indexed line along each survey transect. It is useful to have two, as they can be leapfrogged 

from one transect to the next as the survey progresses. The distance intervals marked are 

generally 5, 10 or 20 feet for a survey conducted in English units and 1, 5 and 10 meters in 

metric units. The marked distance interval required for a particular survey will be 

determined by the survey objective and the required level of survey detail and survey 

control. 

It is standard field practice to lay out an orthogonal grid of survey lines. These lines must be laid 

out so that they provide the required level of survey coverage to meet the objective(s) of the 

survey i.e. the objective(s) that require the highest spatial resolution. During the course of survey 

layout, it is a standard and highly recommended practice to create a map of the survey grid with 

specific grid locations referenced to permanent or semi-permanent surface features. The 

investigator should update this map, along with the survey notes if any of the data acquisition or 

survey grid parameters are changed during the survey. 

In many cases, the origin is a pre-surveyed point or benchmark, or a GPS geo-referenced 

location. In the absence of a pre-existing survey origin, the investigator will have to select a 

relative survey origin point. This point may be the corner of a lot, a building, or some other 

permanent surface feature. The investigator must act as surveyor and lay out two orthogonal 

baselines. Standard surveying practice is to define the direction of the baseline relative to 

geographic north and east. Often the requirements of survey coverage and site conditions require 

that the baseline direction be something other than a cardinal point (i.e. due north or due east). 

Standard mapping convention is to orient north to the top on the site map and east to the right on 

the site map. The baseline is designated north if its compass bearing is more than 45  north-

northeast i.e. the baseline is aligned more in a north-south than east-west direction. Otherwise, 

the baseline direction is defined as east. The easiest way to lay out an orthogonal grid is to use 

the right triangle method. This assures that the baseline and transect lines are at right angles to 

each other and that the survey grid is square. This is achieved by laying out two survey tapes to a 

distance that is approximately 25-50% of the actual survey gird size at approximately right 

angles to each other. Using the familiar Pythagorean Theorem; A
2
 + B

2
 = C

2
, one can quickly 

and easily lay out orthogonal baselines. An example for performing this is illustrated in  

Figure 109. 

 

Figure 109: Right triangle method for establishing and orthogonal survey grid baseline.  

Leg A = 10 ft. Leg B = 10 ft. Leg C (the Hypotenuse) = 14.1421 ft. 
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Given the relationship A
2
 + B

2
 = C

2
 and that the Leg A =10 ft and the Leg B = 10 ft, we can see 

that A
2
 + B

2 
= 200. Taking the square root of C = 200, we arrive at C = 14.1421 ft. If we place 

the end of the third tape (C) at the 10 ft mark of B and the 14.1421 ft mark of tape (C) at the 10 ft 

mark of A, we will have a right triangle and the baseline will be square. The transect lines for the 

survey can now be marked off at regular intervals. Site conditions and line lengths may 

necessitate the laying out of several of these “corners,” particularly on large open survey sites, to 

assure that the entire grid is square, that the survey lines are parallel and that the line spacing is 

consistent at the beginning and end of the transects. This method can easily be expanded for 

larger survey areas by using multiples of 10 for the A and B legs of the triangle and calculating 

the square root of the sum A
2
 + B

2
. 

 

Figure 110: Example section of site plan map. 

Figure 110 is an illustration of an example site plan map. This is an example of the line-and-

station system used by most investigators in the field. An origin (relative, benchmarked or geo-

referenced) is defined for the local co-ordinate system. The distance along the baseline from the 

survey origin to an orthogonal survey line is (generally) given as the survey line number i.e. a 
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transect line 20 feet east of the origin would be survey line 20E, a survey line 20 feet west of the 

origin would be survey line -20E (or 20 W) and so forth. The distance along the survey (or 

transect) line is the station, or station number. If the baseline is oriented north, then the survey 

direction is east. In this illustration, the baseline is east and the survey direction is both north and 

east. 

It is best practice to collect data in both directions. The survey grid should be laid out in such a 

fashion that the survey lines are normal (i.e., perpendicular) to the presumed or visible trend of 

any feature(s) of interest. Based upon anomalous instrument readings acquired during the course 

of the survey, supplemental lines that are intermediate to the survey grid lines or oblique i.e., at 

an angle, to the survey grid, should be acquired to better constrain the location and extent of 

suspected anomalies.  

The use of GPS systems to collect geo-referenced data along with geophysical data has become 

much more prevalent in recent years and the EMP-400 is equipped with a WAAS (Wide Area 

Augmentation System) GPS and is compatible with external, high-resolution GPS systems. 

In many survey locations, the absence of sufficient satellite coverage and the multi-path 

interference caused by nearby buildings or other structures may render the use of GPS 

positioning systems impractical or problematic at best.  

The investigator should carefully evaluate the line-of sight conditions at the site and the true 

position accuracy of the GPS system to be used. The user should always consult a GPS mission 

planner and a have recent satellite ephemeris and almanac data on the position of visible 

satellites prior to using a GPS system for geo-referenced survey data. (Note: A free mission 

planner called QuickPlan and the current ephemeris and updated almanac can be downloaded 

from Trimble at: www.trimble.com/support_trl.asp?NAV=Collection-3627.) 

The positional accuracy of the survey is directly related to the regularity of the line spacing and 

consistency of the measurement interval along each survey line. This is where survey ropes can 

prove to be extremely useful. When strung between the endpoints of the survey line, they 

provide a straight line for the investigator to follow as data is collected. In situations where 

survey ropes are impractical (e.g., collecting data along very long transects) plastic survey pin-

flags, or stationed wooded stakes should be used at 10 to 20 foot intervals, or 5 to 10 meters 

intervals, to serve as a walking guide for the investigator.  

C.3 An Example Survey 

Let us assume for the moment that the objective of our survey is to detect and delineate the 

buried foundation of an old paint factory. Review of geologic and hydrogeologic data indicate 

that the surficial geology of the area was originally part of an outwash plain characterized by 

buried stream channels, gravel deposits and course to fine grain inter-bedded sand and silt. 

Historical records indicate that the site has seen significant modification and that most of the 

native subsurface materials have been re-distributed, removed and/or replaced by heterogeneous 

fill materials of variable composition. Review of available records indicates that masses of 

buried paint cans have been buried in shallow (< 4 ft deep) trenches, or as individual groups of 

cans scattered about the site. These are suspect as being the point sources for groundwater 

pollution detected in on-site monitoring wells. In this case, the detection of small, metallic 

targets buried at moderate to shallow depths would present the most difficult of the survey 

http://www.trimble.com/support_trl.asp?NAV=Collection-3627
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objectives. Given the site geologic conditions, small metallic targets will only be detectable at 

relatively shallow depths and at small lateral distances from the instrument.  

To meet the survey objective, we would like to have the transects a short distance apart, 

approximately 1 meter. Ideally we would like to operate the instrument in close proximity to the 

surface; approximately 10-20 cm. As no hard data is available to us on the actual depth of burial 

of the targets, we must assume that they are buried at or near the maximum depth of 

investigation range of the instrument.  

As the geologic and land-use data indicate that the subsurface materials are generally resistive, 

the frequency(ies) of operation should be selected such that the response from the depth range of 

interest is maximized. Given a site with these conditions, a general rule of thumb would be to 

conduct preliminary test transects in the mid to upper frequency range of instrument, i.e., from 9 

to 16 kHz. As system response and depth of exploration are a function of both subsurface 

conductivity and the frequency(ies) of operation, it is advisable that the user conduct test 

transects at several frequencies prior to commencing the survey. 

The system can be operated in either the in-line orientation, with the instrument transmitter and 

receiver aligned and parallel with the survey transect, or the broadside orientation with the 

instrument transmitter and receiver on two parallel traverse lines and the line between the 

transmitter and receiver aligned perpendicular to the transect direction.  

Each method has its advantages and disadvantages. Under certain field conditions, collecting 

data with the in-line method affords the operator somewhat greater control over unwanted 

movement of the coils during data collection. Using the broadside method, controlling the 

orientation of the instrument can prove more difficult, as the instrument may tend to swing from 

side to side as the operator walks along the survey transect. This type of coil motion can have 

adverse affects on the quality of the data.  

In areas of significant surface vegetation, in-line operation is advantageous, as the instrument 

presents a smaller cross-section to surface obstructions such as high grass, brush, bushes, and 

trees. Operation in the in-line orientation may be desirable in locations where the operator has a 

priori information regarding the trend of linear conductive targets, such as large metallic utilities, 

the orientation of buried foundation walls, or the strike of a geologic feature, such as a 

conductive dike. In-line survey transects can then be collected perpendicular to the trend (strike) 

of the target, reducing possible asymmetries in the target response.  

As the transmitter and receiver are on separate transects, data collected along a survey transect in 

the broadside orientation will cover a larger area than a traverse collected in the in-line 

orientation for an instrument with fixed coil spacing. Operation in the broadside orientation will 

also (generally) produce narrower, tighter anomalies, and therefore better spatial resolution than 

operation in the in-line orientation. This is because standard data-point plotting convention for 

moving source methods is to plot each measurement at the midpoint between the transmitter and 

receiver. Given a conductive target of limited dimension and two traverses collected over the 

target, one in the in-line orientation and the other in the broadside orientation, the number of 

survey data points along the transect at which the instrument will register a response is much 

smaller for the broadside orientation than the in-line orientation. The instrument response for an 

in-line transect over such a target will be stretched out along the line of the transect in 

comparison to the response from an equivalent broadside transect. 
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